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 Introduction
 
Goals of This Lesson

 Describe the relationship between Parts, Assemblies and Drawings.

 Identify the principal components of the SOLIDWORKS user interface.

 Download and extract the required companion files.

Using This Book

The Bridge Design Project helps you learn the principles of structural analysis using 
SOLIDWORKS and SOLIDWORKS Simulation as an integral part of a creative and 
iterative design process.

For this project, you will “learn by doing” as you complete a structural analysis. 

What is SOLIDWORKS Software?

SOLIDWORKS is design automation software. In SOLIDWORKS, you sketch ideas and 
experiment with different designs to create 3D models using the easy to learn Windows® 
graphical user interface. 
SOLIDWORKS is used by students, designers, engineers and other professionals to 
produce single and complex parts, assemblies and drawings.

Prerequisites

Before you begin the Bridge Design Project you should complete the following tutorials 
that are integrated in the SOLIDWORKS software: 

 Lesson 1 - Parts

 Lesson 2 - Assemblies

 Lesson 3 - Drawings

You can access the tutorials by clicking Help, SOLIDWORKS Tutorials, Getting Started. 
The tutorial resizes the SOLIDWORKS window and runs beside it.
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As an alternative, you can complete the following lessons from CAD Student Guide:

 Lesson 1: Using the Interface

 Lesson 2: Basic Functionality

 Lesson 3: The 40-Minute Running Start

 Lesson 4: Assembly Basics

 Lesson 6: Drawing Basics

Conventions Used in This Book

This manual uses the following typographical conventions:

Before You Begin

If you have not done so already, copy the companion files for the lessons onto your 
computer before you begin this project.

1 Start SOLIDWORKS.

Using the Start menu, start the SOLIDWORKS application.

2 SOLIDWORKS resources. 

Click the SOLIDWORKS Resources tab  and click Student 
Curriculum. 

Convention Meaning

Bold Arial SOLIDWORKS commands and options appear in this style. For 
example, Insert, Boss means choose the Boss option from 
the Insert menu.

Courier 
New

Feature names and file names appear in this style. For example, 
Sketch1.

17 Do this 
step.

The steps in the lessons are numbered in Bold Arial.
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3 SOLIDWORKS Content.

Expand the SOLIDWORKS Educator Curriculum folder. 

Expand the proper Curriculum <year> folder.

Click the Bridge Design Project folder.

The lower pane will display an icon representing a Zip file 
that contains the companion files for this project.

4 Download the Zip file.

Press Ctrl and click the Bridge Design Project - English 
icon.

You will be prompted for a folder in which to save the 
Zip file.

Ask your teacher where you should save the Zip file. 
Usually the C:\Temp folder is a good location.

Click OK. 

Tip: Remember where you saved it.
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5 Open the Zip file.

Browse to the folder where you saved the Zip file in step 4.

Double-click the Bridge Design Project.zip file.

6 Click Extract. 

Click Extract and Browse to the location where you want to save the files. The system 
will automatically create a folder named Bridge_Design_Project_ENG in the location you 
specify. For example, you might want to save it in My Documents. Check with your 
teacher about where to save the files.

You now have a folder named Bridge Design Project on your disk. The data in this folder 
will be used in the exercises.

Tip: Remember where you saved it.

Analyzing a Structure Using SOLIDWORKS and SOLIDWORKS Simulation

During this session, you will learn how to analyze a structure using SOLIDWORKS and 
SOLIDWORKS Simulation. You may also build the structure using balsa wood (see 
Building the Structure on page 81). 

Once you have had a chance to see how easy it is to use SOLIDWORKS solid modeling 
software, you will use an assembly to check whether components fit properly. 

You will then make a drawing of one of the components, complete with a cut list. If a 
printer is available, you can print out a hardcopy of your drawing.
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 Lesson 1: Structure Design
 
Goals of This Lesson

 Define a structure.

 Describe several types of trusses.

 Understand what beams are.

 Understand what factors provide strength in a beam.

 Calculate a moment of inertia.

 Understand the importance of triangular bracing in a structure.
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What is a Structure?

Structures are frames commonly used bridges for railroads, automobile and foot traffic. 
Examples of these structures can be seen across the country and the world. 

Structure Designs

Structure designs are meant to be simple structures that are efficient, meaning that they are 
easy to build and accomplish their goals with the minimum amount of materials. There are 
many different structure designs, the differences are based on the load that the structure is 
required to support and the span that it must cross. The structure design may be repeated 
over several spans in the same bridge. 
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Trusses

Trusses are specific types of structures commonly used on railroad bridges. They usually 
consist of a road or rail surface (deck), two walls and sometimes bracing on the top. You 
will be analyzing a truss design.

Search on truss for more information. 

Brown Truss

The Brown Truss (patent shown here) was used in 
the design of covered bridges. This truss is a “box” 
truss (named for its boxy shape) that was so efficient 
that it could be constructed using only the (diagonal) 
cross bracing beams to support it.

Warren Truss

The Warren Truss is another simple and economical 
design. It can be reversed and used with or without the 
vertical bracing depending on the load it needs to carry.

Pratt and Howe Trusses

The Pratt Truss and Howe Truss are very similar. Like the 
reversed Warren Truss shown above, they both have 
vertical and cross bracing. The difference is the direction 
of the cross bracing. 
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Beams

A Beam is an object that has the same cross 
section along its whole length. In this case, the 
cross section is square. Structures like trusses 
are composed of beams. 

Steel Beams

Steel beams use standard shapes like channels, I-beams and tubes.

Strength

The strength of a beam depends on two factors, the 
Cross Section Shape and the Material. 
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Cross Section Shape

Stacking two square beams creates a “deeper” section. 
The deeper the section (left) the stronger the beam. 
Wider sections (right) help a little but not that much. 

Try it!

Notice the difference in resistance between 1 balsa wood beam and 3 stacked beams when 
you try to press down. Use pencils for support and distance. 

Displacement

One of the results that we will be searching for in the structural analysis is the largest 
Displacement. It is the distance that the beam moved from the start when it an external 
force was applied to it. The displacement will help us determine the capacity of the 
structure. 

Area Moment of Inertia

The reason that deeper beams are stronger is because of the Area Moment 
of Inertia. This is a formula calculated using the width (b) and height (h) 
dimensions of the cross section. It is a measure of the strength of the beam 
section alone, not the material. 

The Area Moment of Inertia is used in calculations as resistance of a beam 
to bending. The higher the value, the more resistance against bending. 

Displacement
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Calculating the Area Moment of Inertia

Using the formula below, you can calculate this value for several arrangements of 
rectangular cross sections. 

Try some calculations

Try some calculations using the formula above and the values shown in the table below. 
The values are based on the cross section of a balsa wood beam, 3.175mm (1/8”) square. 

Questions

1 Which arrangement has the largest value? _____________

2 Is the 2 side by side as strong as the 2 stacked arrangement?_______

3 Which arrangement is the weakest?_____________?

Number of 
square sections

Arrangement 
of square 
sections b h

Area Moment 
of Inertia

1 3.175mm 3.175mm _________

2 Stacked 3.175mm  2 X 3.175mm _________

2 Side by Side 2 X 3.175mm 3.175mm _________

3 Stacked 3.175mm 3 X 3.175mm _________

AreaMomentofInertia
b h3

12
---------------=
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Material

The material of the beam is another critical factor in 
determining the strength of the beam. Take three materials 
as an example: Wood, Copper, and Steel. The relative 
strength of each is shown in a chart at the right. In general, 
steel is stronger than copper, which in turn is stronger than 
wood. Keep in mind that there are a wide range of values 
within every material type and there are several types of 
Material Properties such as Young's modulus and Poisson's 
ratio that are used to define a material. 
Note:Metals are manufactured products and due to the way they are created, they have 

equal strength in each direction. Materials like this are called isotropic materials. 

Search on material properties for more information. 

Wood as a Material

Wood is an especially difficult material to predict because it has a grain within it. The 
grain causes the strength to be different in each direction and it is not really an isotropic 
material. The porosity of Balsa wood makes it very susceptible to moisture which can 
cause large variations in the property values. 

The values that we are using are estimates. If you choose to build and test a structure your 
results will be relative but the values may vary. 
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Truss Walls

The side walls of a truss are much more than just a fence to prevent objects from falling 
off. The walls usually contain bracing in the vertical and diagonal directions. When a truss 
contains both vertical and diagonal bracing, it is generally more stable. 

Triangles

Many structures, especially truss designs, contain triangles. Why are triangles so 
important? One reason is for stability. Stability is achieved by using cross braces to form 
triangles. Triangular shapes create stability in the truss. 

Consider a collection of members connected in a 
square shape by bolts or pins. Holding the bottom 
still, push on the top or side. It can form a square 
but can also be easily pushed into a flattened 
parallelogram. 

Adding a 5th member diagonally makes a big 
difference. The shape is now locked in that position. The addition 
has broken the parallelogram into two triangles. 

Using the same members and fasteners, create a triangle. This 
time fewer members are used but stability is achieved. 
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Try it!

You can simulate this process using something as flexible as a drinking straw. Use small 
pins to connect them together.
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 Lesson 2: Using the Beam Calculator
 
Goals of This Lesson

 Start SOLIDWORKS.

 Add-in the SOLIDWORKS Simulation software.

 Open an existing SOLIDWORKS part.

 Understand a simply supported beam.

 Assign a material.

 Calculate section properties.

 Use the measure tool.

 Use the beam calculator to calculate a displacement.

Using Beam Calculations

Before you perform any kind of an analysis, it is a good idea to have some idea on what 
results to expect. Although you will not know how much weight the structure can 
withstand, you can make an educated guess on one or more of the results that you will get. 
This is where beam calculations, simple formulas for beams, can be used. Below are some 
of the beam calculations available. 

Note:Hand-calculated type beam calculations typically include 
formulas and look like this. 
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Order of Magnitude

Will the displacement (see Displacement on page 5) be close to 1mm? 10mm? The 
difference is 10 times greater than the previous one and are increasing by what is called an 
Order of Magnitude. An initial calculation can give you an idea of the order or magnitude 
of the results. This will help you determine whether the analysis has been done correctly. 

Questions

1 What is the next value after 1mm and 10mm using an increasing order of 
magnitude?_____________

2 What values are missing in this set? 5mm, _______, 500mm 

Starting SOLIDWORKS and Opening a Part

1 Start the SOLIDWORKS application.

From the Start menu, click Programs, SOLIDWORKS, SOLIDWORKS. 

Adding in SOLIDWORKS Simulation

SOLIDWORKS Simulation software is included with SOLIDWORKS Education 
Edition. To use it, it must be activated using Tools, Add-Ins. Click both Active Add-ins 
and Start Up for SOLIDWORKS Simulation, SOLIDWORKS Toolbox Library, and 
SOLIDWORKS Toolbox Utilities and click .

Where to Find It

• Menu Bar: Options, Add-ins 

• Menu: Tools, Add-ins 

2 Add-in selections. 

Click Tools, Add-ins and make sure that 
Active Add-ins and Start Up for 
SOLIDWORKS Simulation, 
SOLIDWORKS Toolbox Library, and 
SOLIDWORKS Toolbox Utilities are 
checked. 

Click .
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Warning!

If SOLIDWORKS Simulation, SOLIDWORKS Toolbox Library, and SOLIDWORKS 
Toolbox Utilities are not added in the project cannot be completed.

Opening a Part

Existing SOLIDWORKS files can be opened using the Open tool.

Where to Find It

• Menu Bar: Open 

• Menu: File, Open

• Keyboard Shortcut: Ctrl+O

3 Open the part file.

Click Open .

From the Open window, browse to the Bridge 
Design Project\Student\
Lesson 2 folder. 

Select TRUSS_1.sldprt and click Open.

The Model Geometry

This model is made up of a series of beams that are placed against each other. The beams 
represent balsa wood sticks. In your project, the beams are combined by gluing them 
together. In a real structure, the beams would be welded or bolted together.
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Simplifying the Analysis

The model appears as two parallel beams connected by smaller beams in several places. If 
we take just half of the model (just the large beam) and apply 1/2 the loads, we should get 
some idea of what the values will be in the real analysis. 

The Simply Supported Beam

This type of beam calculation is often referred to as a “simply supported beam” where the 
contact points are not completely fixed and a load is applied. There are two key definitions 
you will need to know: fixtures and external loads. 

Fixtures 

Fixtures are used to limit movement of certain points in the model. These are usually 
points of contact. They are also called constraints or restraints. 

External Loads

External loads or forces can be used to add Force or Gravity loads to the structure. 
Adding a force requires a location on the structure, a value (in Newtons) and a direction. 
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Theoretical Model

This is the theoretical model (right) of the beam supported by the pencils in the previous 
lesson. 

Why are Simply Supported Beams Important? 

Although the theoretical model may seem overly simple, it serves as a practical 
approximation for many real structures. There are examples of the simply supported beam 
in use in many places. 

Structures 

Wood and steel frame spans for homes and buildings are 
designed using simply supported beams. 

Trebuchet 

The trebuchet arm rotates on an axis between the frames. The axle is 
a simply supported beam. 

Mountainboard 

If you were standing in the middle of a mountainboard, you would be 
the external load and the wheels would be the fixtures. The structure can 
be approximated with a simply supported beam. 

Note:This example is a “simplified analysis” that takes a 3 dimensional problem and 
simplify it to a 2 dimensional problem. A full simulation would still be needed. 

Fixtures

External
Load
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Conservative Assumptions

Engineers often use “conservative assumptions” to make the analysis worse than reality 
for the structure. Doing this adds an extra level safety to the design and makes it stronger 
than it has to be. Here are some assumptions that will be made: 

1 Using the ends of the structure as fixtures is worse than using the actual points of 
contact. 

2 Using a single external load at the center is worse than two external loads near the 
center. 

Required Data for the Beam Calculation

There are several pieces of data that are required to use this beam calculation. They 
include: 

Common Units

Common metric units are used in this project. Some of the common units used in the SI 
and IPS (inch, pounds, seconds) units systems are: 

Note:We will use the SI unit system in this analysis. The SI system of units is also 
known as the International System of Units. It uses metric units such as meters., 
millimeters and Newtons. 

Search on International System of Units for more information. 

Data Where to Find It? What is it?

Modulus of Elasticity Material Properties Stiffness of material

Moment of Inertia Section Properties Resistance to bending 

Length Geometry Length to cross span

Load (given) External load 

Data SI Units IPS Units

Modulus of Elasticity  Pa, MPa, psi

Moment of Inertia mm^4, cm^4, m^4 in^4

Length mm, cm, m in, ft

Load N, kN lb
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Collect the Data

The required data will be collected using several different tools in upcoming steps. You 
will calculate the missing values in the chart below.
Note:As an initial guess, we will assume that the total weight load on the full structure 

is 40N. We will use half of that, 40N/2 = 20N, for the beam calculation. 

Assign a Material

The first step is to assign a Material to the beams of the model. We want to make the 
structure out of balsa wood.

Where to Find It

• Menu: Edit, Appearance, Material

• Shortcut Menu: Right-click the Material feature click Edit Material

Data Value Units

Modulus of Elasticity (pressure) ???? Pa (Pascals)

Moment of Inertia (length^4) ???? cm^4 

Length ???? mm

Load (force) 20 N (Newtons) 
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4 Material. 

Right-click the Material feature and select Edit Material. Expand the 
SOLIDWORKS Materials and Woods folders on the left and click Balsa. 

Under Units, select SI - N/m^2 (Pa). 

Click Apply then click Close. 

Note:The material used, Balsa, is chosen to make the analysis useful to those who will 
actually design, construct and test the structure. Balsa wood is a common 
material for student building projects. 

The value of the Elastic Modulus or Modulus of Elasticity = 
2999999232 N/m^2. 

*You will learn more about materials, construction and testing in later lessons.
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Section Properties

The section properties are based on the cross section of the beam. 

5 Zoom to area. 

Click View, Modify, Zoom To Area and drag a window, upper left to lower right, 
around the corner of the structure as shown. 

Note:Press the Esc key to turn off the zoom tool. 

6 Face selection. 

Select the face as shown.
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Where to Find It

 CommandManager: Evaluate > Section Properties 

 Menu: Tools, Section Properties

7 Section properties. 

Click Tools, Section Properties. Click Options and Use custom settings. Select 
Centimeters and 6 decimal places as shown. 

Click OK and Recalculate. 

Moments of inertia of the area, at the centroid: (centimeters ^ 4) Lxx = 0.025405. Click 
Close. 

8 Zoom. 

Click View, Modify, Zoom To Fit or click the f key to return to the full view. 
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Using Measure

Measure can be used to measure distances or angles using model geometry.

Where to Find It

• CommandManager: Evaluate > Measure 

• Menu: Tools, Measure

9 Measure. 

Click Tools, Measure. Select an edge of the beam as 
shown. The length of the beam is displayed. 
Length: 400mm.

10 Close.

Click the “x” in the upper right hand corner of the dialog to close it.

Beam Calculator

The beam calculator uses the input to determine the largest displacement or deflection of 
the beam.

Where to Find It

• Menu: Tools, Toolbox, Beam Calculator 

11 Start beam calculator. 

Click Beam Calculator.

12 Settings. 

Clear any values in the Deflection field (the Solve button will not be available until 
that field is cleared). Use the scroll bars to access Supported at both ends, load in 
middle. Click Y local axis, Metric and Deflection. 
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13 Type in values. 

Type or copy and paste the values listed below into the dialog: 

14 Solve.

Click Solve. The displacement is about 35mm at the load. Click Done. 

Questions

1 Is this displacement more or less than an inch?_____________

2 Convert the displacement to inches: 35mm/25.4 = _____________in

15 Close the part. 

Click File, Close to close the part. 

At the Save changes to TRUSS_1? message, click Don't Save. 

Data Value Units

Modulus of Elasticity (pressure) 2999999232 Pa (Pascals)

Moment of Inertia (length^4) 0.025405 cm^4 

Length 400 mm

Load (force) 20 N (Newtons) 
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 Lesson 3: Analyzing the Structure
 
Goals of This Lesson

 Understand what SOLIDWORKS Simulation does.

 Describe the stages of a Structural Analysis.

 Understand the environment of the analysis including fixtures and loads.

 Use SOLIDWORKS Simulation.

 View the results of an analysis.

Analysis of the Structure

During this lesson, you will use SOLIDWORKS Simulation to analyze the beam 
structure. 

What is SOLIDWORKS Simulation?

SOLIDWORKS Simulation is a structural analysis tool for designers that is added into 
SOLIDWORKS. With this software you can analyze the solid model directly. You can 
also easily set up units, material type, external loads and more by using a study. You can 
make changes to the solid model and update the structural analysis results.

There are several steps to the analysis:

1 Create a design in SOLIDWORKS.
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SOLIDWORKS Simulation can analyze parts and assemblies.

2 Create a new static study in SOLIDWORKS Simulation. SOLIDWORKS Simulation 
projects will contain all the settings and results of a problem and each project that is 
associated to the model. This includes: adding fixtures, adding external loads and 
meshing the model. 

3 Run the analysis. This is sometimes called solving.

4 Viewing the SOLIDWORKS Simulation results which includes plots, reports and 
eDrawings. 

Structural Analysis

Structural Analysis is an Engineering process that uses Physics and Mathematics to 
predict how a structure will behave under external loads such as weights and pressures. 
Buildings, bridges, aircraft, ships and automobiles are among the many products that 
require structural analysis. 

Through structural analysis we can determine Stresses, Factor of Safety and 
Displacements.

Stresses: The external loads applied to a structure create internal forces and stresses that may 
cause the structure to fail or break. 

Factor of Safety: The factor of safety (FOS) is a ratio of the actual stress divided by the 
maximum stress the material can handle. 

If the FOS > 1, the structure is safe. If the FOS < 1, the structure is considered unsafe.

Displacements: As mentioned in a previous lesson, the external loads applied to a structure 
can force the structure to move from its unloaded position. The displacement is the distance a point 
moves from its original position. 

Structural analysis is used in many fields of the manufacturing industry:

 Buildings and Bridges
Floors, walls and foundation. 

 Aircraft
Aircraft fuselage, wings and landing gear. 

 Ships
Hulls, bulkheads and superstructure.

 Automobiles
Chassis, body and crash testing.

MaximumStressunderLoading
MaximumStressoftheMaterial
-------------------------------------------------------------------------------- FOS=
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Why Do Design Analysis?

After building your design in SOLIDWORKS, you may need to answer questions like:

 Does the truss cover the required span?

 What is the most efficient design for the truss?

 What is the maximum load that the truss can handle?

In the absence of analysis tools, expensive prototype-test design cycles take place to 
ensure that the product’s performance meets customer expectations. Design analysis 
makes it possible to perform design cycles quickly and inexpensively on computer models 
instead. Even when manufacturing costs are not important considerations, design analysis 
provides significant product quality benefits, enabling engineers to detect design problems 
far sooner than the time it takes to build a prototype. Design analysis also facilitates the 
study of many design options and aids in developing optimized designs. Quick and 
inexpensive analysis often reveals non-intuitive solutions and benefits engineers by 
allowing them to better understand the product’s behavior.

Structural Analysis Stages

SOLIDWORKS Simulation walks you through several stages of structural analysis. This 
is what is happening behind the scenes:

 Pre-Processing- In this stage, you add the required information about the structure 
and the environment. This includes materials, fixtures and external loads applied to the 
structure. 

 Analysis- The model is broken down into tiny pieces called elements using a process 
called meshing. In this project, the elements are Beam Elements. This information is 
then used to create a finite element model and is solved. This includes the Analyze 
page of the SOLIDWORKS Simulation wizard. 

 Post-Processing- The results are presented to you in a graphic form so you can 
identify the problem areas. This includes the Optimize and Results pages of the 
SOLIDWORKS Simulation wizard. 

Once all the stages are complete, you can save all the analysis information with the model. 
When the analysis information is saved, future changes will be faster. 
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Design Cycle

The Design Cycle is used to make a change to the model or the pre-processing 
information. Model changes would be size changes such as the length of beams. Changes 
to the pre-processing information would include changes to the material, fixtures or 
loading. Either change forces the model to be re-analyzed, cycling until the best solution is 
reached.

Changes in the Model

The SOLIDWORKS part is now very simple, but sides and braces will be added and you 
will see why they are important aspects of the structure. Let’s open it and take a look at the 
model and what it represents.

1 Open the part file again.

Click Open .

From the Open window, browse to the Bridge 
Design Project\Student\
Lesson 2 folder. 

Select TRUSS_1.sldprt and click Open.

This is the same part that was used in the 
previous lesson. 

SOLIDWORKS

SOLIDWORKS

Satisfied?

Prototype

No

Yes

Design
Cycle

Simulation
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Create a Study 

In order to perform a structural analysis, a new study must be created. 

SOLIDWORKS Simulation uses a Study to store and organize all the data associated with 
a structural analysis. 

The study is also used to specify the type of analysis that you are running. Many types are 
available. They include: 

 Static

 Frequency

 Buckling

 Thermal

 Drop test

 Fatigue

 Nonlinear

 Linear Dynamic

 Pressure Vessel Design

In this project we will be using a Static analysis. This type of study is used to the predict 
where a structure will fail due to stress.

Where to Find It

• CommandManager: Simulation > Study Advisor  > New 
Study 

• Menu: Simulation, Study

2 Create a new study. 

Click Simulation, Study. Use the default name Static 1 and click 
Static.

Click . 
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FeatureManager Design Tree and Simulation Study Tree 

The FeatureManager Design Tree appears above the Simulation Study Tree on the left 
side of the screen. The upper tree lists the features of the model geometry while the lower 
tree lists the features of the analysis or simulation model. 

The Environment

The environment describes how the structure is 
used. In this case, the model represents a structure 
crossing a river. From knowing the placement of 
the structure and the external loads that must cross 
it, we can determine two critical items required for 
SOLIDWORKS Simulation: the Fixtures and the 
External Loads. 

FeatureManager

Simulation

Design Tree

Study Tree

 Model

Simulation
Model
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Fixtures

The Fixtures are the areas of the structure that 
will be fixed or limited in movement. We define 
the span as the crossing distance that is not 
supported, 350mm in this case. On each end, there 
is 25mm of overlap where the structure ends are 
supported by the abutment or shore. The span is 
always less than the full length of the structure.

The fixtures are defined at the ends of the model in 
four places. 

External Loads

The model must have External Loads that 
impose forces onto the structure. Let’s say a 
rectangular stack of bricks is sitting in the 
center of the span, crossing the structure. 
Assume that the total weight of the bricks is 
40N. 

There are four loading points, one for each 
point where the beams connect near the center 
of the span. This means that the load on each 
point is 40N/4 = 10N (about 2.25lbs).

Abutment

Load

Structure
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Why is the load in the center?

When using a structural analysis model, 
engineers like to perform what is called a 
“worst case” analysis. This is the situation 
where the structure is most likely to break due 
to the conditions of the environment. 

Placing the load at the center of the span is the 
worst case for a truss structure like this. 

How much do you think it will hold?

The structure is fairly weak at this point, but you will strengthen it as you go through this 
guide. What is the maximum force it can withstand? Take a guess.

Force = __________N
Note:If you are thinking in terms of pounds (lb), start thinking in metric terms. 

Convert pounds to newtons (N) using this formula: 

1 lb = 4.4482 N

Unit Settings

The Options can be set to create consistent results throughout the analysis. In this 
example, mm and MPa will be selected for use.

Where to Find It

• Menu: Simulation, Options

3 Set the units. 

Click Simulation, Options and click 
the Default Options tab. Under Units, 
select mm for Length/Displacement 
and 
N/mm^2 (MPa) for Pressure/Stress. 

Click OK.
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Pre-Processing

The first stage of the structural analysis is the pre-processing, gathering all the required 
information and applying it to the simulation model. The information that we will supply 
or create includes: 

 Material - The material of the beams.

 Fixtures - Positions that cannot move freely. 

 External Loads - Forces that are applied to the model. 

 Mesh - A simulation model, based on the model, that breaks the beams up into small 
pieces called elements.

Material

The Material is a required value that sets the material properties and appearance of the 
model geometry. In this case it will be applied to all the beams at once.

Where to Find It

• CommandManager: Simulation > Apply Material  

• Menu: Simulation, Material, Apply Material to All

• Simulation Study Tree: Right-click the part name and select Apply/Edit Material

4 Set the material. 

Click Simulation, Material, Apply Material to All. Expand the Woods folder and select 
Balsa. Click Apply and Close. 

What are Joints? 

Joints are generated automatically where the 
centerlines of beams meet. These joints will be used 
to locate the fixtures and external loads that follow. 

Fixtures 

Fixtures are used to limit movement of certain points in 
the model. The points where the ends of the structure sit 
on the abutment will be assigned fixtures. 

What type of fixtures?

In this project, the bridge will be placed on the abutment 
so that it crosses the span. The bridge will contact the 
abutment but it will not be glued or attached in any way.
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Where to Find It

• CommandManager: Simulation > Fixtures Advisor  > Fixed Geometry

• Menu: Simulation, Loads/Fixture, Fixtures

• Simulation Study Tree: Right-click Fixtures and select Fixed Geometry

5 Add fixtures. 

Click Simulation, Loads/Fixture, Fixtures. Click Immovable (No translation)  
and select the joints as shown. 

Note:To correct errors, right-click in the box where the selections are listed and select 
Clear selections. When the box is emptied, try selecting again. 

6 Size of symbols. 

Expand the Symbol Settings section and increase the Symbol 
Size to 150. This makes the symbols larger and more visible. 
Click . 

External Forces

The total force on the structure will be divided equally into four 5N forces placed near the 
center of the structure. 

Forces

Forces have direction and a value (magnitude). They can be a direct force like hanging a 
weight or a moment that twists or bends like turning a doorknob. 
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Gravity

Gravity uses the weight of the structure as a load. It is not significant in this project and 
will not be considered.

Where to Find It

• CommandManager: Simulation > External Loads Advisor  > Force

• Menu: Simulation, Loads/Fixture, Force

• Simulation Study Tree: Right-click External Loads and select Force

7 Add forces. 

Click Simulation, Loads/Fixture, Force. Click Joints  and 
select the visible joints as shown. 

8 Set direction. 

Click in the Direction field and expand the Flyout FeatureManager Design Tree. Click 
the feature Top Plane. 

9 Set units. 

Make sure that Units are set to SI. 
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10 Assign force. 

Click Normal to Plane  and set the value to 10N as shown. Click 
Reverse direction to get the arrows pointing down. 

Click . 

Tip: The Symbol Settings options can be used like those in fixtures to increase or reduce the size of 
the symbol. These have been set to 150. 

11 Save. 

Click Save  to save the model and simulation data. 

Tip: It is a good idea to save periodically and prevent unintentional loss of data.
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Meshing the Model

The mesh must be created to generate the small pieces used in the analysis. The analysis 
model is made up of a series of connected nodes and elements. 

Where to Find It

• CommandManager: Simulation > Run  > Create Mesh 

• Menu: Simulation, Mesh, Create

• Simulation Study Tree: Right-click Mesh and select Create Mesh

12 Meshing. 

Click Simulation, Mesh, Create. A mesh is created using the geometry of the model. 

Note:This step is automatically included within Simulation, Run but is shown here to 
highlight the mesh. 

Element

Node
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Analysis

The analysis portion is the easy part. SOLIDWORKS Simulation takes your input and 
does the work to find the results. You will use the default settings so that the results will be 
faster. 

Expectations

In the previous lesson, beam calculations were used to determine a rough displacement 
based on a simplified analysis of a simply supported beam. That analysis determined that 
the displacement was approximately 35mm. We expect that the displacement we get from 
the simulation analysis falls in the same order of magnitude; between 3.5mm and 350mm; 
hopefully close to the 35mm result.

Where to Find It

• CommandManager: Simulation > Run This Study  > Run This Study

• Menu: Simulation, Run, Run

• Simulation Study Tree: Right-click the study name and select Run

13 Run. 

Click Simulation, Run. When the run is 
complete, you will see two features in the Results 
folder of the Simulation Study Tree. 

The simulation is ready for post-processing. 
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Some Terminology

While the analysis is running, let’s look at some terminology that will help with 
interpretation of the results.

Bending and Displacement

Bending is caused by a load that is applied to a 
beam. The load causes the beam to bend and 
move in the direction of the load. 

The Displacement is the movement of the 
beam from its original position. The “worst 
case” displacement occurs when the load is at 
the center of the beam.

You can see displacement if it is large enough, 
but it is usually very small. 

Is there a place in your house where the floor 
creaks when you walk over it? The creaking is 
caused by the displacement of the floor beam 
bending under a load- your weight! 
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Tension and Compression

While the beam bends, the top portion of the beam (the face where the load is applied) 
compresses (pushing together) while the opposite face sees tension (pulling apart). 

Search on tension and compression for more information.

Stresses

Stress is a quantity measured by force per unit 
area inside a structure that is caused by external 
loads applied outside of the structure. You 
cannot see stress but it can cause your structure 
to break. 

Common units are Newtons per meter squared, 
Pascals and pounds per square inch (psi). 

Stress can cause the beam to break under a 
load. SOLIDWORKS Simulation provides 
maps that show areas of high and low stress on 
the structure. 

Yield Strength

How much can the beam take before it breaks? We use the Yield Strength as the limit of 
the beam’s strength based on the stresses that the beam sees. Both the material and beam 
section contribute to the strength.
Note:In metals, the material will often bend under load but will return to its original 

shape when the load is removed. The yield strength is the point where the 
material bends and stays bent after the load is removed. This is called a Plastic 
Deformation.

Factor of Safety

The Factor of Safety (FOS) is a quick way to see the results of the analysis. It is defined 
as the ratio of the highest stress and the yield stress of the material. If the FOS > 1, the 
structure is safe. If the FOS < 1, the structure is unsafe. 
Note:Engineers generally design for a FOS of more than 2. Structures are generally 

“over designed” for safety and reliability. 

Search on stress (physics), yield strength or factor of safety for more 
information. 

Tension

Compression
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Post-Processing

Once the analysis is complete, post-processing can begin. Post-processing produces two 
plots in the Results folder of the Simulation Study Tree that can be viewed and modified. 
These plots will help you understand and modify the bridge structure. 

As post-processing begins, two plots are posted in the Results folder: 
Stress 1 (-STRMAX-High axial and bending) and 
Displacement1 (-Res disp-). 

The stress plot is selected and viewed automatically. 

14 Stress distribution.

The display shows the model with displacement. The Stress Distribution is 
represented by the colors on the displaced model. The chart shows the distribution; 
warm colors for higher stresses, cool colors for lower stresses. 

Note:The joints  can be hidden. Right-click Joint group and select Hide or Show. 

15 Displacement. 

Double-click the Displacement1 (-Res disp-) plot to view it. 
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Interpreting the Results

The stress and displacement plots are helpful because they tell us the actual values and 
where they are highest. What is a MPa? Lets get some sense of what the results mean. 
Here are results so far (yours may vary): 

Numbers

The displacement is shown in scientific notation. (your results may have a different 
combination of formats). 

3.798e+001 means 3.798 X 101 or 3.798 X 10^1= 3.798 X 10 =______mm

What is that in inches? Divide the result above by 25.4 = ______in

Units

Understanding units is important in interpreting the results. Length units like mm or 
inches are familiar. Stress may not be. Stress units are those of pressure, measuring force/
area. You may have seen psi (pounds per square inch) when you pump up a bicycle tire. 
Here is a tire pressure in common units: 

60 psi = 4.136854e+005 Pa = 0.4136854 MPa (1 MPa = 1 N/mm^2=1,000,000 Pa)

Creating a New Plot

What we need to know is: how much stress can the structure withstand? The best solution 
is to create a Factor of Safety plot. It is a three step process.

Where to Find It

• CommandManager: Simulation > Results Advisor  > New Plot > Factor of 
Safety 

• Simulation Study Tree: Right-click on the Results folder and click Define Factor of 
Safety Plot

Stress Displacement

38.683MPa (Megapascals) 3.798e+001mm
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16 Factor of Safety Plot. 

Right-click on the Results folder in the 
Simulation Study Tree and select 
Define Factor of Safety Plot.

Keep the default settings and click 
Next . 

Keep the Multiplication factor at 1 
and click Next .

Click Areas below factor of safety.

Click .

Note:The current factor of safety is listed as 0.517024, or about 0.5, in the dialog box. 
This is less than the minimum value of at least 1. The plot appears with 
everything colored blue or red.

What does the Factor of Safety Plot Tell Us?

The areas below factor of safety are shown as red on the plot. If a FOS of 1 is the limit, 
that means that the loading is too heavy for the structure to support. 

The load must be reduced. 
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Iterating Changes

Since the structure cannot support the load, the next step is to find out what load the 
structure can support. To do this, we will change the load, re-analyzing the structure until 
we can get the FOS to about 1. This is called iterating.

Determine the Load

Before we iterate a change and decrease the load, we need to decide how much of an 
decrease is required. The current information tells us that the FOS is about 0.5 for a load 
of 4 X 10N = 40N. 

If we multiply the FOS times the total load, the result should produce a FOS of about 1.

FOS X Total Load = 0.5 X 40N = 20N or 5N per face

Using iteration, we will reanalyze the model to see if this formula can be validated.

Editing Simulation Data

Simulation data, such as an external load, can be edited to reflect the new value. The 
results will not update until the analysis has been rerun.

Where to Find It

• Shortcut Menu: Right-click the fixture or load feature and select 
Edit Definition

17 Edit external load. 

Right-click the feature 
Force-1 (:Per item: -10 N:) and select Edit Definition. Set the 
load to 5N and click . 

18 Rerun.

Click Simulation, Run to rerun the analysis. 

19 Factor of Safety. 

Double-click the result Factor of Safety1 (-Automatic-). The FOS is blue meaning greater 
than 1. 

20 Close the part.

Click File, Close and click Save to save changes. 

Conclusion

From the analysis, it is obvious that the structure was inadequate to support the initial 
load. Using SOLIDWORKS Simulation, we were able to iterate and find the highest load 
that the structure could hold.
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Goals of This Lesson

 Understand the importance of cross bracing.

 Find the maximum load.

 View displacement plots.

 Edit plots and charts to enhance viewing.

 Calculate the strength to weight ratio.

Adding to the Design

Based on the analysis of the structure using 
SOLIDWORKS Simulation, we can 
conclude that the structure needs 
strengthening. This version has added side 
walls that strengthen the design and allow 
it carry higher loads. 

Open the Model

1 Open the part file.

Click Open .

From the Open window, browse to the 
Bridge Design Project\Student\Lesson 4 
folder.

Select TRUSS_2.sldprt and click Open.

This version has sides made up of 
horizontal and vertical members.
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Existing Study

This part is the same as the previous one with the addition of the walls. It also has a study 
Study 1 that uses the same values as the previous part. 

2 Access an existing study. 

Click the Study 1 tab located on the lower left portion 
of the screen. The Simulation Study Tree appears. The 
analysis has fixtures, external loads and mesh. 

3 Run the analysis. 

Click Simulation, Run, Run. 

The simulation is ready for post-processing. Note that the factor of safety plot is not 
created automatically.

4 Factor of Safety Plot. 

Right-click on the Results folder in the Simulation Study Tree and select Define Factor 
of Safety Plot. Use the same procedure as Creating a New Plot on page 40. 

5 Labels. 

Right-click the result Factor of Safety1 (-FOS-) and select Chart Options. Click Show 
min annotation and click . 

The results show that the FOS has decreased compared to a similar initial load in the 
previous lesson. 
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Change the Load

Let’s iterate the external loads to see how much this version of the structure can take, 
again using a FOS of 1 as the target. In the previous lesson we learned that multiplying the 
total load by the factor of safety produced the maximum allowable load. 

20N x 0.684 = 13.68N each load is 13.68N/4 = 3.42N 

6 Edit external load. 

Right-click the feature Force-1 (:Per item: -5 N:) and select Edit Definition. Set the load 
to 3.42N and click . 

7 Rerun.

Click Simulation, Run to rerun the analysis. The minimum Factor of Safety should 
again be close to 1. 

8 Close the part.

Click File, Close and click Save to save changes. 

Cross Bracing

In a previous lesson, the value of triangles and 
cross bracing was discussed (Triangles on page 
8). We will look at a structure with some cross 
bracing to see how it changes the results. As 
before, the loading remains at the previous 
setting (3.42N in four places) and everything is 
the same with the exception of the added 
bracing.

Open the Model

1 Open the part file.

Click Open .

From the Open window, browse to the Lesson 4 folder. 

Select TRUSS_3.sldprt and click Open.

This version is similar to the previous one with the 
addition of some cross bracing in the center section.

Existing Study

This part is the same as the previous one with the addition of some cross bracing. It also 
has a study Study 1 that uses the same values as the previous part. 

2 Access an existing study. 

Click the Study 1 tab located on the lower left portion of 
the screen. The Simulation Study Tree appears. The analysis has fixtures, external loads 
and mesh. 

3 Run the analysis. 

Click Simulation, Run. 
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The simulation is ready for post-processing. Create the FOS plot. The value is greater 
than 1 (add labels using the procedure in step 5 on page 44). 

4 Edit external load. 

Right-click the Force-1 feature and select Edit Definition. Set the load to 5.4N and click 
. 

5 Rerun.

Click Simulation, Run, Run to rerun the analysis. The minimum FOS should again be 
close to 1. 

What did the Cross Bracing do?

Cross bracing creates triangles that “stiffen” the frame and help it resist bending and 
twisting. To see how effective it is, we’ll look at the results. 

6 Stress plot. 

Double-click the Stress1 (-STRMAX: Upper bound axial and bending-) plot to see the stress 
plot. 

Working with Plots

There are many options that can be used to make plots easier to read and understand. We 
will look at some options to change the appearance. 

Deformation Plot Factor

The deformed shape of the stress plot may use an exaggerated displacement, which can be 
very large. To exaggerate the displacement, you can set the deformed shape to an 
Automatic or User defined value of your choice. 

7 Deformed shape. 

Right-click the Stress1 (-STRMAX: Upper bound axial and bending-) 
plot and select Edit Definition. Make sure that Deformed Shape 
and Automatic are selected. Click .
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Where to Find It

• Heads-up View Toolbar: View Orientation , Front 

• Keyboard Shortcut: Ctrl+1

8 Front view. 

Click Front  from the View Orientation  icon and look at the stress distribution 
of the model from the front. The center, cross braced, section of the model retains its 
shape better than the end portions due to the strength added by the bracing. 

Superimposing the Model

The Settings options allow you to superimpose the undeformed shape and change the 
appearance of the chart to have show distinct color changes.

Where to Find It

• Shortcut Menu: Right-click a plot and click Settings

9 Settings. 

Right-click the Stress1 (-STRMAX: Upper bound axial and 
bending-) plot and click Settings. 

Under Fringe Options, select Discrete. Under Deformed Plot 
Options, click Superimpose model on the deformed shape 
and set the Transparency to 0.7.

Click . 

Note:The title and color charts can be moved by drag and drop. 
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The Weakest Link

Are you are familiar with 
expression “the weakest 
link”? The literal meaning is 
the most vulnerable portion 
of a chain, the link that is 
most likely to break. 

If you look closely at the 
lower left section of the image, you will see the label of the highest stress value. This is the 
weakest link, a high stress area. 

There should be a similar high stress area (red) on the right side 
near the fixture. Zooming in will show it. 

Stress Distribution Colors

The stress distribution always 
includes a color chart that allows 
you to match the colors with real 
stress values. The highest stress 
is a red/orange/yellow, the 
lowest is shades of blue. 

SOLIDWORKS Simulation is 
used to identify the “weakest 
links” in the model so they can 
be repaired. 

Keep in mind that the highest 
stress may not cause the 
structure to fail. Follow the Yield 
strength arrow, that is the 
failure point.
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Using a Probe

Probes allow you to get deeper information from a plot by selecting elements directly. The 
element will receive a label that displays the exact value, per the type, of that element. 
Plots can also be generated from the probe data.

Where to Find It

• CommandManager: Simulation > Plot Tools  > Probe 

• Menu: Click Simulation, Result Tools, Probe

10 Add a probe. 

Click Simulation, Result Tools, Probe. Select the 
elements from top to bottom, in order, as shown. The 
values show that the stress value increases steeply 
from the first to the last elements selected. 

Note:Make selections similar to those shown here. The labels that you see may have 
slightly different element numbers and values.

1

2

3
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11 Plot. 

Click Plot  to create the Probe Result. 
The change in the stress value across those 
few elements is dramatic as demonstrated 
by the plot. 

Click the “x” to close the Probe Result 
dialog and click  to close the Probe 
Result Property Manager.

12 Isometric. 

Click Isometric  from the View Orientation  icon. 

13 Deformed shape. 

Right-click the Stress1 (-STRMAX: Upper bound axial and bending-) plot and select Edit 
Definition. Click Deformed Shape and Automatic. Click . 

14 Animate. 

Click Simulation, Result Tools, Animate. Move 
the Speed slider to the value 10 as shown. 

Click . 

Tip: The Frames slider can be used to create a smoother 
animation by increasing the number of frames.

Adjusting the Number Format

The values that accompany the charts use a number format based on the size. For instance, 
if the numbers are very small or very large, a scientific notation is used. You can change 
the number format to make the charts easier to read. Here is the same number in three 
different number formats. 

15 Displacement. 

Double-click the Displacement1 (-Res disp-) plot. Displacement numbers tend to be 
small, and in this chart they run between 0 and about 3 mm. They are in scientific 
notation but would be easier to read in a decimal format.

Scientific Floating General

3.727e+000 3.727 3.73
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Where to Find It

• Shortcut Menu: Right-click a plot and click Chart Options

16 Chart options. 

Right-click the Displacement1 (-Res disp-) plot and 
click Chart Options. Under Position/Format, 
select Number Format floating. 

The numbers appear as easier to read floating format 
numbers. 

Click .
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Solution

Now that the weak areas have been identified, they can be addressed. What do you think 
that the best solution to this problem is? 

1 Decrease the load to increase the FOS to a value greater than 1.

2 Add cross bracing to the unbraced sections.

We will choose item 2 and then maximize the load on the structure.

17 Close the part.

Click File, Close and click Save to save changes. 

Finishing the Bracing

To complete the cross bracing, members 
have been added in the outer sections. 
Let’s see what this does to the structure.

1 Open the part file.

Click Open .

From the Open window, browse to the Lesson 
4 folder. 

Select TRUSS_4.sldprt, and click Open.

This version is similar to the previous one 
with full cross bracing. 

2 Rerun. 

Open the existing study Study1 and rerun the analysis. 

Compare Stresses

The added bracing seems to have been very effective. How can we tell? The maximum 
stress has been reduced. 

Would you expect the FOS value to increase or decrease?______

3 Factor of safety plot.

Create a factor of safety plot and check the value of the FOS. 
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4 Maximize the external load. 

Again, we will maximize the load for a factor of safety of 1.

5.64 x 5.4N = ________ N

Edit the Force-1 feature external load and set it 30.46 N. 

5 Rerun.

Click Simulation, Run to rerun the analysis. The minimum FOS should again be close 
to 1. 

6 Displacement. 

Double-click the Displacement1 (-Res disp-) plot. Animate the plot. 

The displacements are smaller but you may notice that the model seems oddly shaped. The 
upper portions of the walls are bending inward. Some additional bracing is required. 

7 Close the part.

Click File, Close and click Save to save changes. 

Top Beams

To complete the structure, members have 
been added to the top of walls, connecting 
them. Let’s see what this does to the 
structure. 
SOLIDWORKS Bridge Design Project 53



Lesson 4: Making Design Changes
1 Open the part file.

Click Open .

From the Open window, browse to the 
Lesson 4 folder. 

Select TRUSS_5.sldprt, and click Open.

This version is similar to the previous one 
with three top braces added. 

2 Open existing study. 

Open the existing study Study 1.

3 Analysis and edits. 

Run the analysis and create a FOS plot. The FOS falls above 1. 

To bring the FOS closer to 1, change the load to 37.95 and rerun.

4 Displacement. 

Although the additional bracing did very little to change the maximum load, it reduces 
the maximum displacement. 

Right-click the displacement result and select Edit Definition. Set the Deformed 
Shape to True scale and click . Also right-click Chart Options and select Floating 
as the Number Format. 
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Strength to Weight Ratio

This is just one of many structures that can be designed to support a load. If there were 
three different structures that could hold three different loads, how could you determine 
which design was the most efficient? The Strength to Weight Ratio (maximum load/
structure weight) can be used. 

What does our Structure Weigh?

Using SOLIDWORKS, finding mass properties is easy. They have been calculated for the 
model automatically.

Where to Find It

• CommandManager: Evaluate > Mass Properties 

• Menu: Tools, Evaluate, Mass Properties

5 Mass properties. 

Click Tools, Evaluate, Mass 
Properties to list the mass 
properties of the part. The key 
information is the line for Mass. 
This is the total weight of the 
structure in grams. 

Click Close.

Note:Conversion of grams to 
newtons: 1 gram is about 0.01 
newtons. 
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Efficiency Comparison

Use the information in the chart below to calculate the Max Load Capacity and 
Efficiency for each iteration in the design. Which design is the most efficient? 

Which iteration of the structure proved to be the most efficient? _________

6 Close the part.

Click File, Close and click Save to save changes. 

Structure Max Load Weight of Structure

Efficiency
(Max Load/
Weight)

TRUSS_1 20N 4.566 g = ______N ________

TRUSS_2 13.68N 7.418 g =______N ________

TRUSS_3 21.6N 8.266 g =______N ________

TRUSS_4 121.84N 9.130 g =______N ________

TRUSS_5 151.8N 9.508 g =______N ________
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More to Explore

Each simulation can have multiple plots to display the results in different ways, but the 
beam analysis has a unique type, the Beam Diagram. This plot can be used to display 
several quantities directly on the beams. The forces and shears are displayed in Newtons 
(N), the moments and torque in Newton-Meters (N-m). 

A beam diagram can be added to the results by right-clicking the Results folder and 
selecting Define Beam Diagram. One of the above types must also be selected. 

Beam Force Type Force Direction

Axial Force

Shear Force (directional)

Moment (directional)

Torque
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Reading the Plot

As an example, look at a plot using Axial Force. The axial force in the angled brace 
members is blue, meaning that the value is between -44N and -55N. The braces are in 
tension, because their axial force values are negative. 

Note:The axial forces in the vertical member nearest the external loads are very small 
because the braces absorb most of the load. 
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 Lesson 5: Using an Assembly
 
Goals for This Lesson

 Open an assembly.

 Move components in the assembly.

 Check interferences between assembly components.

 Make a change to a part while in the assembly.

Testing an Assembly

Assemblies are SOLIDWORKS files that contain multiple parts. We can use an assembly 
to test whether a test block, representing a vehicle, can be moved through the structure. 

Testing using the Test Block

If you were to build and test this structure, it would have to meet certain criteria for length, 
width and height. One of the criteria would be a test to see if a wooden block of a certain 
size and length could fit through. 

1 Open the assembly file.

Click Open . From the Open 
window, browse to the Bridge Design 
Project\Student\Lesson 5 folder. Select 
Test_Block_Assembly.sldasm, and click 
Open. The assembly includes a copy of 
the previous structure and a 
representation of a wood block.

Where to Find It

• CommandManager: Assembly > Move Component  > Move Component 

• Menu: Tools, Component, Move
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2 Move component. 

Select the Load_Plate_75 component and 
click Tools, Component, Move. In the 
dialog, click Collision Detection, All 
components, Stop at collision, 
Highlight faces and Sound. Select and 
drag the Load_Plate_75 through the 
structure. It should move smoothly through 
and back to the starting position outside the 
structure.

3 Fit. 

The block fits through the structure. In fact, there is a larger 
clearance than is needed. To get the most efficient structure, 
we want to limit the width of the structure so that the block 
fits with a very small clearance. 

Click . 

Changing the Model

Changes made to a model affect the assembly and the analysis. 

4 Expand features. 

In the FeatureManager, double-click the Test_Block_Truss 
component and then the Roadway folder to expand them.

Double-click the Sketch1 feature.
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5 Change dimension.

Double-click the 75 dimension 
and change it to 60. Click 
Rebuild  and . The 
structure part changes size. 

Collision Detection

Clearances are small distances between parts designed to allow them to fit together 
properly. If any part is too small or too large, the assembly will not fit together properly.

6 Move.

Using the same Move procedure as 
before (step 2), try to move the block 
through the structure. It collides with the 
structure. 

Collision Too Wide Proper Clearance
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7 Increase width.

Using the same dimension 
change procedure as before (step 
5), change the dimension to 
74mm. 

8 Correct size. 

This size provides a small clearance and allows the block to slide 
through. 

9 Open the part.

Right-click on the Test_Block_Truss in the FeatureManager and select Open Part . 
The structure part opens in its own window. 

Updating the Analysis

The model has changed and has actually become narrower. The model change will cause 
several errors in the joints which in turn cause errors in the fixtures, loads and mesh. 

10 Warnings and errors. 

Click Study 1. There are warning and error markers 
on several features. 
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11 Joint group. 

Right-click the Joint Group and select Edit. 

Click Calculate and . 

The message says Joints are recalculated. Calculated joints may look 
same, but the order may be different. Re-definition of fixture/load/connection 
may be required. Click OK. 

12 Fixture. 

Right-click the fixture Immovable-1 and select Edit Definition. Check to see that the 
same four (green) joints are selected and click . 
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13 Load. 

Right-click the external load Force-1 (:Per item: -37.95 N:) and select Edit Definition. 
Check to see that the four joints as shown are selected and click . 

14 Mesh and run. 

Right-click the Mesh feature and select Mesh and Run. The changes are insignificant. 
Click File, Close and save all changes.
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 Lesson 6: Making Drawings of the Structure
 
Goals of This Lesson

 Add a drawing view of the part.

 Create a weldment cut list table.

 Add balloons to a drawing view.

Drawings

SOLIDWORKS allows you to easily create drawings of parts and assemblies. These 
drawings are fully associative with the parts and assemblies they reference. If you change 
a dimension on the finished drawing, that change propagates back to the model. Likewise, 
if you change the model, the drawing updates automatically.

Drawings communicate three things about the objects they represent:

 Shape – Views communicate the shape of an object.

 Size – Dimensions communicate the size of an object.

 Other information – Notes communicate nongraphic information about manufacturing 
processes such as drill, ream, bore, paint, plate, grind, heat treat, remove burrs and so forth.

Creating a Drawing and Views

Once the model has been completed, a drawing can be made using that part. In this 
example, a blank drawing sheet has been associated to the part. 

1 Open the part file Drawings. 

From the Open window, browse to the 
Bridge Design Project\Student\Lesson 6 folder.

The part is a completed model of the 
structure. 
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2 Open drawing file. 

This part has an associated drawing file. It has no 
drawing views or notes, but it contains many of the 
setting that we need. To open it, right-click in the 
graphics area, then click Open Drawing.

3 Expand View Palette.

Click on the View Palette  to expand it. The view 
palette contains views of the current part. Click 
Refresh  and clear Import Annotations. Drag and drop an *Isometric view from the 
View Palette to the drawing sheet. 
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4 Drawing view properties. 

Select Shaded With Edges  from Display Style. Click Use 
sheet scale.

Click  to complete the view.

What is a Weldment Cut List Table?

The Weldment Cut List Table is a listing of the members or beams in the part. They are 
sorted into groups by length, and include an item number, quantity, description and length. 
All this information is extracted from the part.

Where to Find It

• CommandManager: Annotation > Tables  > Weldment Cut List 

• Menu: Insert, Tables, Weldment Cut List

5 Weldment Cut List. 

Click Insert, Tables, Weldment Cut List and select the 
drawing view.

Select the file Bridge_Weldments.sldwldtbt as the Table 
Template.

The file is stored in the folder Bridge Design 
Project\Student\Lesson 6, the same folder as the part.

Click  and move the cursor onto the drawing.
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6 Place table. 

Move to the upper left corner of the 
drawing and click to place the table. 

7 Resize columns. 

Drag the column and row borders of the table to resize them. 
Each column and row border can be resized. 

Why are there two Items of the Same Length? 

A different beam than what corresponds to the top member of the walls is 
used to represent the stack of three beams that makes up the bottom of the 
bridge. So although items 1 and 3 are the same length, they are considered 
different beams. 

Tip: In the building section the actual sizes of the individual beams will be listed. 
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Balloons

Balloons label the members in the part and relate them to the cut list numbers on the 
weldment cut list.

Where to Find It

• CommandManager: Annotation > Balloon 

• Menu: Insert, Annotation, Balloon

8 Balloons. 

Click Balloon. Click on the member and then 
click to place the text. Repeat the process to 
add some balloons.

Click . 

Note:You can move balloons by dragging the 
text.

9 Balloon quantities. 

The quantity of items in a balloon can be set. Click a balloon 
and click Quantity.

Select a Placement and click . 

10 Close the drawing and part.

Click File, Close and save all the files.
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 Lesson 7: Reports and SOLIDWORKS eDrawings
 
Goals of This Lesson

• Create an HTML report.

• Load the SOLIDWORKS eDrawings add-in.

• Describe a SOLIDWORKS eDrawings file.

• Create SOLIDWORKS eDrawings of SOLIDWORKS Simulation data.

• Save the SOLIDWORKS eDrawings file as an HTML file.

Reports and SOLIDWORKS eDrawings

There are many ways to generate data from the structural analysis. A Report is useful for 
printing and viewing text and static data. Use SOLIDWORKS eDrawings to view, share 
and manipulate the analysis result plots without having to open the part. 

1 Open the part file Reports&eDrawings. 

From the Open window, browse to the Bridge Design Project\Student\Lesson 7 folder.

Open the part file Reports&eDrawings. Click Static 1 and run the analysis.

Creating a Report

Using SOLIDWORKS Simulation, you can create a printable report that captures all the 
important data.

Where to Find It

• CommandManager: Simulation > Report 

• Menu: Simulation, Report

2 Report. 

Click Simulation, Report. 
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3 Dialog. 

Click Designer and Company. In Designer, add your initials. In Company, add the 
name of your school. 

4 Logo. 

Click Logo. Click the Browse button and select the file logo.bmp from the Lesson 7 
folder. 
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5 Description. 

Click Description and type This is the structural analysis of a balsa wood truss into the 
comments section and click Publish. 

Tip: The Report path can be set to receive the report and associated data. 
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6 Report. 

The report, complete with data and images, appears in a new window as soon as it is 
generated. Close the window or print the report. 

The results are placed in the same folder as the part by default. They can be printed and 
opened independently of SOLIDWORKS or SOLIDWORKS Simulation. 
Note:Do not close the part.
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SOLIDWORKS eDrawings for Sharing Information

eDrawings® is an email-enabled communications tool designed to dramatically improve 
sharing and interpreting 2D mechanical drawings. eDrawings are small enough to email, 
are self-viewing and significantly easier to understand than 2D paper drawings.

Advantages of eDrawings

 Recipients do not need to have the SOLIDWORKS application to view the file.

 View parts, assemblies and drawings outside of SOLIDWORKS.

 Files are compact enough to email.

 Creating an eDrawing is quick and simple.

 Publish an eDrawing from any SOLIDWORKS file.

 You can create eDrawings from other CAD systems, too.

Viewing eDrawings

You can view eDrawings in a very dynamic and interactive way. Unlike static 2D 
drawings, eDrawings can be animated and viewed dynamically from all angles. The 
ability to interact with eDrawings easily — in an interactive manner — makes it a very 
effective design collaboration tool.

eDrawings Professional gives you the ability to perform mark-up and annotation of 
eDrawings which further enhances design collaboration.

Viewing eDrawing Animations

Animation automatically demonstrates how drawing views relate to each other and to the 
physical design. With the click of a button, eDrawings “animates” all views contained in 
each sheet of your drawing, morphing from one view to another.

The animation continuously shows you the eDrawing from different views. This dynamic 
motion is similar to turning a part around in your hand as you inspect it.
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Creating a SOLIDWORKS eDrawing

eDrawings are an easy way to share data, especially the image data that is generated by 
SOLIDWORKS Simulation. 

7 Plot. 

Double-click the Displacement1 (-Res disp-) plot to activate it. This is the plot that will be 
saved into the eDrawing. 

8 Save. 

Click Simulation, Result Tools, Save As. Save the data using the 
eDrawings Files (*.analysis.eprt) file type. Click Save. 

The default name is of the form: 
part name-study name-results-plot type. In this case it is 
Reports&eDrawings-Static 1-Results-Displacement1.analysis.eprt 

It is stored in the same folder that was created by the report. 

9 Open the eDrawing. 

Double-click the eDrawings file in the folder. The eDrawings window appears. 

Note:If eDrawings has not been used before, it may ask permission to load. 
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The eDrawings User Interface.

10 Settings. 

Click the Studies tab , and the options Show Mesh ,

Show Legend  and Show Title . 

eDrawings Functions

You can animate, zoom, scroll, and rotate the image using various tools. 

11 Move components.

Click Zoom to Area  and drag a window around the center section of the 
structure. 

Playing an eDrawings Animation

12 Play the animation.

Click Play . This starts a continuous forward play loop showing each view in 
sequence. The animation sequence is system controlled; you cannot set the sequence.

13 Stop the animation.

Click Stop  to stop the animation. 

14 Reset the view.

To return the animation to the start of the sequence, click Reset .
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Saving eDrawings

Click File, Save , or press Ctrl+S to save the file currently open in the eDrawings 
Viewer. You can save files as the following file types:

 eDrawings files (*.eprt, *.easm, or *.edrw)

 eDrawings Zip files

• The eDrawings Zip file contains the eDrawings Viewer and the eDrawings file. You 
can unzip the eDrawings Zip file and run the eDrawings executable file to extract the 
embedded eDrawings Viewer and open the embedded eDrawings file.

 eDrawings HTML files

 eDrawings executable files

• You can save files as self-extracting eDrawings executable (*.exe) files that contain 
the eDrawings Viewer and the eDrawings file. Some email programs, anti-virus 
programs, and internet security settings prevent receiving email with executable files 
as attachments.

 BMP, TIFF, JPEG, PNG or GIF image files

• You can save all file types that you can open in the eDrawings Viewer as BMP 
(*.bmp), TIFF (*.tif), JPEG (*.jpg), PNG (*.png), or GIF (*.gif) files.

Save the eDrawing

15 Save the eDrawing. 

Click File, Save As. For Save as type: click eDrawing HTML Files (*.htm) to save the 
eDrawing as an HTML file. This file can be viewed in a web browser. Click Save.

Save the file in the Reports&eDrawings-Static 1 folder.

16 Close all files. 
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More to Explore

A beam mesh is very quick and efficient method to analyze a beam model and works well 
to reflect the overall state of the structure. However, beam elements cannot analyze what 
happens across the thickness of the beam because they only generate results at the nodes 
which lie at the centerline of the beam. 

Using a solid mesh creates elements and nodes across the thickness of the model. This 
provides multiple nodes across the thickness and results across the thickness. 

To explore, open the part file Solid_Element_Analysis and click Simulation, Run. The 
results plots are arranged the same way as those in a beam analysis. 
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 Lesson 8: Building and Testing the Structure
 
Goals of This Lesson

 Open and print informational PDF files.

 Cut the beams to the proper lengths.

 Assemble the beams to create the truss.

 Test the truss by applying a load. 

Building the Structure

If your class chooses to build and test the structure, you will need 1/8” x 1/8” balsa wood 
sticks. Lengths of at least 24” or 400mm are required. Glue and a knife to cut the sticks are 
also required.

Cutting to Length

There are 43 members of 8 different lengths required to build this structure. There are 2 
PDF files that can be helpful during the construction process. They are located in the same 
folder as these instructions. 
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1 Open and print Measuring Chart.PDF file.

Browse to the Lesson 8 folder, open the Measuring Chart.PDF file and print it using the 
precautions stated in the PDF and in the note below. 

Note:Print this PDF using the Page Scaling: None option to get accurate values!

Cut out this Load Plate shape
to test the inside width of your
structure.

Measure and cut the members using
this length chart. All dimensions are mm.
82 SOLIDWORKS Bridge Design Project



Lesson 8: Building and Testing the Structure
2 Open and print Construction Guide.PDF file.

Open the Construction Guide.PDF file and print it.
SOLIDWORKS Bridge Design Project 83



Lesson 8: Building and Testing the Structure
3 Lower frame. 

Glue the end cross beams to the long beams. Do not glue the interior cross beams yet. 
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4 Fill in beams. 

Fill in between the beams (cross hatched area) by cutting beams to fit and placing them 
in position. Glue all beams.

Fill in between beams
SOLIDWORKS Bridge Design Project 85



Lesson 8: Building and Testing the Structure
5 Triple outer rails. 

Glue the long beams over the fill in beams as shown. Glue all beams.
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6 Side walls.

Glue all beams.

Tip: You might want to build a side and then cross brace it (step 7 on page 88) before starting on the 
opposite side. 
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7 Cross bracing.

The brace members must all be cut (45 degrees) to fit within the existing framing. Glue 
all beams.
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8 Top cross supports.

Glue all beams.
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Testing the Structure

The structure can be tested by placing it across a gap and applying a load at the center of 
the bridge. See the following details for more information. 

Creating the Span

One way to create a span is to place two sawhorses a set distance apart as shown below. 
Placing the model so that it overlaps each sawhorse the same amount simulates the 
environment of the analysis.

Details

Use two surfaces that are strong and equal 
height (sawhorses or tables work well) to 
create the span of 350mm that is required. 
Each end of the structure should overlap 
the surface 25mm. 

Tip: Make sure that the tables or sawhorses are 
strong enough to be able to take the load 
without bending. 
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Applying the Load

In order to measure the strength of a structure, it should be loaded as it was modeled. 

Using Common Objects with Known Weights

Many common objects can be used to apply the load. Food cans come in different sizes; 
they can be weighed and used. Coins can also be used to apply a load in very small 
increments. Let’s take a penny as an example.

1 Penny applies about 0.0245N of force to the structure. That isn’t very 
much, not close to the total load that we would like to test. Does anyone 
really want to count hundreds or thousands of pennies for every test? 
Coins can be rolled in large quantities for deposit at a bank. Pennies are 
rolled into groups of 50. Do some calculations for large numbers of pennies, rolls and cost. 

Holding the Load

Suspend a rope handled shopping bag or something stronger from the Load Plate 
by feeding the rope through the hole in the plate and pinning it with a nail or pen. 
Add the load by filling the bag, slowly, with the weights that you have chosen. 

Pennies Load (N) Penny Rolls Cost ($)

50 50 X 0.0245 = 1.225 1 $0.50

100 ___X 0.0245 = _____ ____ ____

500 ___X 0.0245 = _____ ____ ____

1000 ___X 0.0245 = _____ ____ ____

5000 ___X 0.0245 = _____ ____ ____
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 Lesson 9: Weldment Profiles and Structural Members
 
Goals of This Lesson

 Create a new weldment profile.

 Create a weldment sketch.

 Add structural members to a weldment sketch.

Creating Weldment Profiles and Structural Members

The parts that were analyzed in the previous lessons are considered to be weldment parts. 
This is a special type of part that is used to model a group of structural members that are 
connected together.

In this lesson you will learn how to create this type of part by modeling pre-fabricated roof 
trusses.
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What is a Weldment?

A Weldment is a part that is made up of multiple solid bodies, known as structural 
members, connected together to form a single structure.

What are Structural Members?

The individual solid bodies represent steel beams or lumber and are called Structural 
Members. The position and length of the structural members are based on cross-sections, 
or weldment profiles, that are applied to the lines of a sketch.

What are Weldment Profiles?

Weldment Profiles are library feature sketches that 
represent standard structural cross-section shapes like 
tubes, I-beams, angles, pipes, channels, and lumber. The 
profile is located by the origin position.

Existing Weldment Profiles

The existing weldment profiles folder is found in C:\Program Files\
SOLIDWORKS Corp\SOLIDWORKS\lang\english\weldment profiles.

The sub-folders ansi inch and iso contain multiple sizes of these common shapes. 

Default Weldment Profile Shapes

rectangular tube angle iron square tube
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Warning for Paths

The full path used in this lesson is based upon the default installation of SOLIDWORKS 
onto the ‘C’ drive. If SOLIDWORKS has not been installed using the default settings, the 
path will require some adjustment.
Note:None of the existing weldment profiles resemble 

the cross-section of the balsa wood sticks or their 
much larger relation, 2x4 lumber. This means that a 
new weldment profile must be created.

Creating a New Weldment Profile

A weldment profile is a 2D sketch that is saved as a specific 
file type under a specific folder.

In this example, the sketch will be a rectangle with center 
placement.

The file type is a library feature. The folder is the weldment 
profiles folder.

The first step is create a new folder in the proper place to 
hold the new file.

The Weldment Profile Folder

All of the weldment profiles are set to be found under a specific folder, the weldment 
profiles folder. You can add a new folder to the default set using New folder. New profiles 
can be placed within the new folder.

1 Folder.

Click Start, Computer and browse to the folder C:\Program Files\
SOLIDWORKS Corp\SOLIDWORKS\lang\english\weldment profiles\ansi inch. 

See Warning for Paths on page 95 for more information.

2 New folder.

Click New folder and rename the folder to lumber.

c channel s section pipe

Default Weldment Profile Shapes
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2 b

Creating a New Part

Sketches are created within parts, so the first step is to create a new part.

Where to Find It

• Menu Bar: New 

• Menu: File, New

• Keyboard Shortcut: Ctrl+N

3 New part.

Click New. Click Part and OK.

Changing the Unit System

The Unit System is a combination of length, mass, and time units used for calculations by 
SOLIDWORKS. Your default unit system can be MMGS, IPS, or some other common 
grouping. In this example, we want the IPS unit system, which includes: Inches, Pounds, 
and Seconds.
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Other types are: 

 MKS (Meter, Kilogram, Second)

 CGS (CM, Gram, Second)

 MMGS (MM, Gram, Second)

4 Unit system.

Select IPS (inch, pound, second) from the Unit System menu . This changes 
the units to inches. 

Note:The menu is located on the bottom of the screen to the right of the message 
Editing Part as shown.

Creating a New Sketch

Sketches are used in SOLIDWORKS to create 2D geometry like lines, arcs, circles, and 
rectangles. They are critical to the creation of geometry in SOLIDWORKS.

Where to Find It

• CommandManager: Sketch > Sketch 

• Menu: Insert, Sketch

• Shortcut Menu: Right-click a plane and click Sketch 

5 New sketch.

Click Front Plane and click Sketch .
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Sketching a Rectangle

A rectangle is a piece of sketch geometry that is comprised of four lines. The Center 
Rectangle version is placed by the center and has two horizontal and two vertical lines.

Where to Find It

• CommandManager: Sketch > Rectangle  > Center Rectangle 

• Menu: Tools, Sketch Entities, Center Rectangle

• Shortcut Menu: Right-click in the sketch and click Center Rectangle

6 Rectangle.

Click Center Rectangle  and click on the origin. Next, 
move diagonally away from center and click a location 
similar to that shown. Click .

Note:The actual size is not important now. It will be 
defined in the following steps.

Dimensioning

The dimensioning tool is called Smart Dimension 
because the same tool is used to create multiple 
dimension types. Dimensions help to define the 
size of the profile and can be used to change it as 
well.

In this section it will be used to create linear 
dimensions, but it is also used to create angular, 
radial, and diameter dimensions.

Where to Find It

•

• Menu: Tools, Dimensions, Smart

• Shortcut Menu: Right-click in the sketch and click Smart Dimension 

7 Vertical dimension.

Click Smart Dimension  and click the left vertical line as shown. Move to the left 
and click again to place the dimension. In the dialog that appears, type 1.5 to set the 
dimension value and click .
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Geometry Color

Why do some lines remain blue while others are now black? A color code is used in the 
sketch to label the status of the geometry. 

 Blue means it is under defined and requires more definition, in this case a dimension. 
This is the unfinished state.

 Black means that it is fully defined. This is the desired state.

 Red means that there is a conflict that must be resolved. An example of this is if you 
were to try to make a line be both horizontal and vertical; it cannot be both and a 
conflict, or over defined state, occurs. This is the broken state.

8 Horizontal dimension.

Click the upper horizontal line as shown. Move up and click again to place the 
dimension. In the dialog that appears, type 3.5 to set the dimension value and click .

Note:The geometry is all black meaning that it is fully defined.

9 Exit the sketch.

Click Exit Sketch  in the upper right corner of the screen.
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Saving the Sketch as a Library Feature

The sketch needs to be saved as a specific file type, a library 
feature, in order to be used as a weldment profile. It also must be 
placed in a folder that is defined to contain weldment profiles.

Where to Find It

• Menu Bar: Save , Save As 

• Menu: File, Save As

10 Library feature.

Click Sketch1 in FeatureManager design tree.

Click File, Save As.

Click Save as type: Lib Feat Part (*.sldlfp).

Browse to the folder C:\Program Files\SOLIDWORKS Corp\SOLIDWORKS\
lang\english\weldment profiles\ansi inch\lumber.

Note:The selection of the sketch first is critical.

11 Name.

Type the name 2 by 4 and click Save.

Note:A warning might appear saying that you do not have permission to save in this 
location. If this occurs, save the file to another location and then manually move 
it to the lumber folder in the location above.
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Creating a Similar Weldment Profile

Different profiles are needed to represent different shapes or sizes of weldment profiles. A 
larger lumber section, a 2x6, can be created from the existing 2 by 4 weldment profile by 
copying and editing the file.

12 Save as.

Click Save As, name the new library feature 2 by 6 and click Save.

Edit Sketch

Existing sketches can be edited to add or change the geometry or dimensions.

Where to Find It

• Shortcut Menu: Right-click a sketch and click Edit Sketch 

• Menu: Select a sketch and click Edit, Sketch

13 Edit sketch.

Right-click the sketch Sketch1 and click Edit Sketch . Double-click the 3.5 
dimension and change it to 5.5. Click .

14 Exit the sketch.

Click Exit Sketch  in the upper right corner of the screen.

15 Save and close.

Click File, Close and click Save.

Additional Information About Weldment Profiles

A more general type of weldment profile for this shape would include a Point  at the 
midpoint of each edge as shown below. This would provide more flexibility in positioning 
the profile. They are not needed in this example.
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Creating the Weldment Sketch

The weldment sketch is used to define the position and length of all the structural 
members.

16 Open the part M Roof Truss.

Click Open .

From the Open window, click the type: 
SOLIDWORKS Files (*.sldprt; *.sldasm; *.slddrw) and browse to the 
Bridge Design Project\Student\Lesson 9 folder.

Select M Roof Truss.sldprt and click Open.
Note:The units of this part are feet with the material set as Pine.

17 Change to front view.

Click View Orientation  and click Front .

18 Edit sketch.

Edit the sketch Sketch1. For more information, see Edit Sketch on page 101.
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Sketching a Line

Each line defines a single structural member in the weldment.

Where to Find It

• CommandManager: Sketch > Line 

• Menu: Tools, Sketch Entities, Line

• Shortcut Menu: Right-click in the sketch and click Line

19 Vertical line.

Click Line . Click at the origin, move vertically and click again as shown. 
Note:The Vertical relation marker  indicates that the line is exactly vertical.

20 Angled line.
Click again on the lower left endpoint to add another line as shown.

21 Vertical brace.

Create a line by clicking on the lower horizontal line and moving vertically upwards. 
Click again on the angled line to create a short, vertical line.
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22 Angled brace.

Move back to the origin and click again to create an angled brace. Click .

23 Vertical dimension.

Click Smart Dimension , click the vertical line and add a dimension. Set the 
dimension value to 5 as shown.
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24 Dimension between lines.

Click the short vertical line followed by the center vertical line. Click below the sketch 
and place the dimension. Set the dimension value to 6 and Click .

Mirror Entities

Sketch geometry can be copied by mirroring it across a line.

Where to Find It

• CommandManager: Sketch > Mirror Entities 

• Menu: Tools, Sketch Tools, Mirror
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25 Entities to mirror.

Click Mirror Entities  and click the three lines shown below.

26 Mirror about.

Click in the Mirror about field and click the center vertical line 
as shown. Click .

27 Exit the sketch.

Click Exit Sketch  in the upper right corner of the screen.

28 Save.

Click Save .

29 Change to isometric view.

Click View Orientation  and click Isometric .
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Adding the Structural Members

The structural members are added using the existing sketch geometry with a selected 
profile. 

Structural Member

The length of a structural member is based on the length and position 
of the selected line.

Group

Groups are sets of selections that force one structural member to be 
trimmed against others. This allows each structural member to be 
automatically trimmed to the proper size and shape.

CommandManager Tabs

Not all of the CommandManager tabs are 
visible. If the Weldments tab is not 
visible, right-click on the any of the 
CommandManager tabs and click 
Weldments to show it.

Where to Find It

• CommandManager: Weldments > Structural Member 

• Menu: Insert, Weldments, Structural Member
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30 Structural member.

Click Structural Member  and click ansi inch, lumber and 2 by 4. 
Click the lower horizontal line as shown. Do not click ok yet.

Note:The preview shows the orientation of the profile as it is applied to the line.

31 New group.

Click New Group and select both of the upper angled lines. Do not click ok yet.
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32 Next new group.

Click New Group and select the center vertical line. Do not click ok yet.

33 Next new group.

Click New Group and select both of the outer vertical lines. Do not click ok yet.

34 Final new group.

Click New Group and select both of the outer angled lines.

Click .

35 Change to front view.

Click View Orientation  and click Front .

36 Hide sketch.
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Right-click Sketch1 and click Hide .

Multiple Bodies

The result of adding structural members is that multiple bodies are created in the part. Due 
to the use of New Group, each one is trimmed to the proper size and shape.

37 Edit feature.

Right-click the Structural Member1 feature and click Edit Feature 
.
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38 Change size.

Select the Size 2 by 6 and click .

39 Close the part.

Click File, Close and click Save to save changes. 
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 Glossary
 Term Definition

analysis The process modeling the behavior of a structure to determine 
whether it can withstand the external loads it is designed to handle. 
Quantities such as displacements, stresses and factor of safety are 
calculated. 

animate View a model or eDrawing in a dynamic manner. Animation 
simulates motion or displays different views.

assembly An assembly is a document in which parts, features, and other 
assemblies (sub-assemblies) are mated together. The parts and 
sub-assemblies exist in documents separate from the assembly. 
The extension for a SolidWorks assembly file name is *.sldasm. 

beam A beam is a structural member with a constant cross-section. It is 
usually loaded so that it bends. 

bending What happens to a beam when it is loaded along its length. Also 
called flexure.

component A component is any part or sub-assembly within an assembly.

displacement The movement of a beam from its original position after a load is 
applied.

document A SolidWorks document is a file containing a part, assembly, or 
drawing.

drawing A drawing is a 2D representation of a 3D part or assembly. The 
extension for a SolidWorks drawing file name is *.slddrw.

drawing sheet A drawing sheet is a page in a drawing document. 

eDrawing Compact representation of a part, assembly, or drawing. 
eDrawings are compact enough to email and can be created for a 
number of CAD file types including SolidWorks and SolidWorks 
data.

element A simple shape used to represent a small piece of the the model. 
The sum of all the elements represents the entire model. 

environment The outside factors that affect the structure. They include external 
loads applied to it and places where it is restrained from 
movement.

external load A force or pressure that is applied to a structure from the outside. 
For a truss, it might be the weight of a train.
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face A face is a selectable area (planar or otherwise) of a model or 
surface with boundaries that help define the shape of the model or 
surface. For example, a rectangular solid has six faces.

factor of safety A value that is calculated in an analysis that determines whether a 
structure is strong enough to withstand the external loads applied 
to it.

feature A feature is an individual shape that, combined with other features, 
makes up a part or assembly. Features are always listed in the 
FeatureManager design tree. 

FeatureManager
design tree

The FeatureManager design tree on the left side of the SolidWorks 
window provides an outline view of the active part, assembly, or 
drawing.

fixture Fixtures are used to limit movement of points in the model. They 
are also called constraints or restraints. 

graphics area The graphics area is the area in the SolidWorks window where the 
part, assembly, or drawing appears.

line A line is a straight sketch entity with two endpoints. A line can be 
created by projecting an external entity such as an edge, plane, 
axis, or sketch curve into the sketch.

material What is used to create the beams in the structure. In a real 
structure, it would commonly be steel, but it can be wood or 
concrete. We are using wood.

meshing The process of dividing the model into small pieces called 
elements. 

model A model is the 3D solid geometry in a part or assembly document. 
If a part or assembly document contains multiple configurations, 
each configuration is a separate model.

named view A named view is a specific view of a part or assembly (isometric, 
top, and so on), or a user-defined name for a specific view. Named 
views from the view orientation list can be inserted into drawings.

newton The SI (m-kg-s) unit of force. A force of one newton will 
accelerate a mass of one kilogram at the rate of one meter per 
second per second. In traditional English terms, one newton is 
about 0.225 pounds of force (lbf). The newton is named for Isaac 
Newton (1642-1727). He was the first person to understand clearly 
the relationship between force (F), mass (m), and acceleration (a), 
expressed by the formula F = ma.

node A point used to connect and shape elements. 

part A part is a single 3D object made up of features. A part can 
become a component in an assembly, and it can be represented in 
2D in a drawing. Examples of parts are bolt, pin, plate, and so on. 
The extension for a SolidWorks part file name is .sldprt.

Term Definition
114 SOLIDWORKS Bridge Design Project



Glossary
pascal The SI (m-kg-s) unit of pressure and stress. It is defined as one 
newton per square meter. In traditional English terms, one pascal is 
about 145.04×10-6 pounds per square inch (psi). Because it is a 
very small amount, the related units MPa (Megapascals) and kPa 
(thousand Pa) are often used. The pascal is named for Blaise 
Pascal (1623-1662), a famous mathematician and physicist. 

rectangle A combination of four lines forming a rectangular shape in a 
sketch.

restraint The restraint describes that part of the model that cannot move in 
the analysis. 

sketch A 2D sketch is a collection of lines and other 2D objects on a plane 
or face that forms the basis for a feature such as a base or a boss. A 
3D sketch is non-planar and can be used to guide a sweep or loft, 
for example.

SolidWorks
Simulation

The software within SolidWorks that is used to perform a 
structural analysis. 

simulation study A folder used to store a complete analysis including: materials, 
fixtures, external loads and mesh. 

simulation study
tree

A tree structure, similar to the FeatureManager Design Tree, that 
contains the features that make up a simulation. 

strength The strength or stiffness of a beam includes both the cross section 
shape (area moment of inertia) and material.

stress Stress is a quantity measured by force per unit area inside a 
structure that is caused by external loads applied outside of the 
structure. Common units are Pascals and pounds per square inch. 

stress distribution A “map” of colors that displays the amount of stress anywhere on 
the part. Colors are used to represent stress value ranges.

structure A collection of beams that are used to form a single part. In 
SolidWorks, this type of part is called a weldment; multiple pieces 
welded into one.

structural
analysis stages

The stages in a generic analysis including pre-processing (setup), 
analysis and post-processing (looking at the results). Specifically, 
we use SolidWorks Simulation. 

structural
member

A single body in a weldment structure that represents a beam or 
length of lumber.

tension and
compression

Internal forces in a beam that are caused by bending.

truss A simple bridge structure usually used by railroads.

unit system A combination of length, mass and time units usually described by 
the selections such as IPS or MMGS.

weldment A structure based on a 2D or 3D sketch, a profile and multiple 
bodies in a single part.

Term Definition
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weldment profile A 2D sketch that represents the cross-section of a structural 
member.

yield strength The limit of a beam’s strength based on the stresses in the beam.

Term Definition
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	13 Type in values.
	Type or copy and paste the values listed below into the dialog:
	Modulus of Elasticity (pressure)
	2999999232
	Pa (Pascals)
	Moment of Inertia (length^4)
	0.025405
	cm^4
	Length
	400
	mm
	Load (force)
	20
	N (Newtons)

	14 Solve.
	Click Solve. The displacement is about 35mm at the load. Click Done.

	Questions
	1 Is this displacement more or less than an inch?_____________
	2 Convert the displacement to inches: 35mm/25.4 = _____________in
	15 Close the part.
	Click File, Close to close the part.
	At the Save changes to TRUSS_1? message, click Don't Save.
	Lesson 3: Analyzing the Structure


	Goals of This Lesson
	Analysis of the Structure
	What is SOLIDWORKS Simulation?
	1 Create a design in SOLIDWORKS.
	SOLIDWORKS Simulation can analyze parts and assemblies.
	2 Create a new static study in SOLIDWORKS Simulation. SOLIDWORKS Simulation projects will contain all the settings and results of a problem and each project that is associated to the model. This includes: adding fixtures, adding external loads and me...
	3 Run the analysis. This is sometimes called solving.
	4 Viewing the SOLIDWORKS Simulation results which includes plots, reports and eDrawings.

	Structural Analysis
	Why Do Design Analysis?


	Structural Analysis Stages
	Design Cycle
	Changes in the Model
	1 Open the part file again.
	Click Open .
	From the Open window, browse to the Bridge Design Project\Student\ Lesson 2 folder.
	Select TRUSS_1.sldprt and click Open.
	This is the same part that was used in the previous lesson.



	Create a Study
	Where to Find It
	2 Create a new study.

	FeatureManager Design Tree and Simulation Study Tree
	The Environment
	Fixtures
	External Loads
	Why is the load in the center?
	How much do you think it will hold?
	Note: If you are thinking in terms of pounds (lb), start thinking in metric terms. Convert pounds to newtons (N) using this formula:


	Unit Settings
	Where to Find It
	3 Set the units.
	Click Simulation, Options and click the Default Options tab. Under Units, select mm for Length/Displacement and N/mm^2 (MPa) for Pressure/Stress.
	Click OK.



	Pre-Processing
	Material
	Where to Find It
	4 Set the material.
	Click Simulation, Material, Apply Material to All. Expand the Woods folder and select Balsa. Click Apply and Close.

	What are Joints?

	Fixtures
	What type of fixtures?
	Where to Find It
	5 Add fixtures.
	Click Simulation, Loads/Fixture, Fixtures. Click Immovable (No translation) and select the joints as shown.
	Note: To correct errors, right-click in the box where the selections are listed and select Clear selections. When the box is emptied, try selecting again.
	6 Size of symbols.
	Expand the Symbol Settings section and increase the Symbol Size to 150. This makes the symbols larger and more visible. Click .


	External Forces
	Forces
	Gravity
	Where to Find It
	7 Add forces.
	Click Simulation, Loads/Fixture, Force. Click Joints and select the visible joints as shown.
	8 Set direction.
	Click in the Direction field and expand the Flyout FeatureManager Design Tree. Click the feature Top Plane.
	9 Set units.
	Make sure that Units are set to SI.
	10 Assign force.
	Click Normal to Plane and set the value to 10N as shown. Click Reverse direction to get the arrows pointing down.
	Click .

	Tip: The Symbol Settings options can be used like those in fixtures to increase or reduce the size of the symbol. These have been set to 150.
	11 Save.
	Click Save to save the model and simulation data.

	Tip: It is a good idea to save periodically and prevent unintentional loss of data.

	Meshing the Model
	Where to Find It
	12 Meshing.
	Click Simulation, Mesh, Create. A mesh is created using the geometry of the model.
	Note: This step is automatically included within Simulation, Run but is shown here to highlight the mesh.


	Analysis
	Expectations
	Where to Find It
	13 Run.
	Click Simulation, Run. When the run is complete, you will see two features in the Results folder of the Simulation Study Tree.
	The simulation is ready for post-processing.



	Some Terminology
	Bending and Displacement


	Tension and Compression
	Stresses
	Yield Strength
	Note: In metals, the material will often bend under load but will return to its original shape when the load is removed. The yield strength is the point where the material bends and stays bent after the load is removed. This is called a Plastic Defor...

	Factor of Safety
	Note: Engineers generally design for a FOS of more than 2. Structures are generally “over designed” for safety and reliability.


	Post-Processing
	14 Stress distribution.
	The display shows the model with displacement. The Stress Distribution is represented by the colors on the displaced model. The chart shows the distribution; warm colors for higher stresses, cool colors for lower stresses.
	Note: The joints can be hidden. Right-click Joint group and select Hide or Show.
	15 Displacement.
	Double-click the Displacement1 (-Res disp-) plot to view it.

	Interpreting the Results
	38.683MPa (Megapascals)
	3.798e+001mm
	Numbers
	Units
	Creating a New Plot
	Where to Find It
	16 Factor of Safety Plot.
	Right-click on the Results folder in the Simulation Study Tree and select Define Factor of Safety Plot.
	Keep the default settings and click Next .
	Keep the Multiplication factor at 1 and click Next .
	Click Areas below factor of safety.
	Click .
	Note: The current factor of safety is listed as 0.517024, or about 0.5, in the dialog box. This is less than the minimum value of at least 1. The plot appears with everything colored blue or red.

	What does the Factor of Safety Plot Tell Us?

	Iterating Changes
	Determine the Load
	Editing Simulation Data
	Where to Find It
	17 Edit external load.
	Right-click the feature Force-1 (:Per item: -10 N:) and select Edit Definition. Set the load to 5N and click .
	18 Rerun.
	Click Simulation, Run to rerun the analysis.
	19 Factor of Safety.
	Double-click the result Factor of Safety1 (-Automatic-). The FOS is blue meaning greater than 1.
	20 Close the part.
	Click File, Close and click Save to save changes.



	Conclusion
	Lesson 4: Making Design Changes

	Goals of This Lesson
	Adding to the Design
	Open the Model
	1 Open the part file.
	Click Open .
	From the Open window, browse to the Bridge Design Project\Student\Lesson 4 folder.
	Select TRUSS_2.sldprt and click Open.
	This version has sides made up of horizontal and vertical members.



	Existing Study
	2 Access an existing study.
	Click the Study 1 tab located on the lower left portion of the screen. The Simulation Study Tree appears. The analysis has fixtures, external loads and mesh.
	3 Run the analysis.
	Click Simulation, Run, Run.
	The simulation is ready for post-processing. Note that the factor of safety plot is not created automatically.
	4 Factor of Safety Plot.
	Right-click on the Results folder in the Simulation Study Tree and select Define Factor of Safety Plot. Use the same procedure as Creating a New Plot on page 40.
	5 Labels.
	Right-click the result Factor of Safety1 (-FOS-) and select Chart Options. Click Show min annotation and click .
	Change the Load
	6 Edit external load.
	Right-click the feature Force-1 (:Per item: -5 N:) and select Edit Definition. Set the load to 3.42N and click .
	7 Rerun.
	Click Simulation, Run to rerun the analysis. The minimum Factor of Safety should again be close to 1.
	8 Close the part.
	Click File, Close and click Save to save changes.

	Cross Bracing
	Open the Model
	1 Open the part file.
	Click Open .
	From the Open window, browse to the Lesson 4 folder.
	Select TRUSS_3.sldprt and click Open.
	This version is similar to the previous one with the addition of some cross bracing in the center section.


	Existing Study
	2 Access an existing study.
	Click the Study 1 tab located on the lower left portion of the screen. The Simulation Study Tree appears. The analysis has fixtures, external loads and mesh.
	3 Run the analysis.
	Click Simulation, Run.
	The simulation is ready for post-processing. Create the FOS plot. The value is greater than 1 (add labels using the procedure in step 5 on page 44).
	4 Edit external load.
	Right-click the Force-1 feature and select Edit Definition. Set the load to 5.4N and click .
	5 Rerun.
	Click Simulation, Run, Run to rerun the analysis. The minimum FOS should again be close to 1.
	What did the Cross Bracing do?
	6 Stress plot.
	Double-click the Stress1 (-STRMAX: Upper bound axial and bending-) plot to see the stress plot.


	Working with Plots
	Deformation Plot Factor
	7 Deformed shape.
	Right-click the Stress1 (-STRMAX: Upper bound axial and bending-) plot and select Edit Definition. Make sure that Deformed Shape and Automatic are selected. Click .
	Where to Find It
	8 Front view.
	Click Front from the View Orientation icon and look at the stress distribution of the model from the front. The center, cross braced, section of the model retains its shape better than the end portions due to the strength added by the bracing.


	Superimposing the Model
	Where to Find It
	9 Settings.
	Right-click the Stress1 (-STRMAX: Upper bound axial and bending-) plot and click Settings.
	Under Fringe Options, select Discrete. Under Deformed Plot Options, click Superimpose model on the deformed shape and set the Transparency to 0.7.
	Click .
	Note: The title and color charts can be moved by drag and drop.


	The Weakest Link
	Stress Distribution Colors



	Using a Probe
	Where to Find It
	10 Add a probe.
	Click Simulation, Result Tools, Probe. Select the elements from top to bottom, in order, as shown. The values show that the stress value increases steeply from the first to the last elements selected.
	Note: Make selections similar to those shown here. The labels that you see may have slightly different element numbers and values.
	11 Plot.
	Click Plot to create the Probe Result. The change in the stress value across those few elements is dramatic as demonstrated by the plot.
	Click the “x” to close the Probe Result dialog and click to close the Probe Result Property Manager.
	12 Isometric.
	Click Isometric from the View Orientation icon.
	13 Deformed shape.
	Right-click the Stress1 (-STRMAX: Upper bound axial and bending-) plot and select Edit Definition. Click Deformed Shape and Automatic. Click .
	14 Animate.
	Click Simulation, Result Tools, Animate. Move the Speed slider to the value 10 as shown.
	Click .

	Tip: The Frames slider can be used to create a smoother animation by increasing the number of frames.
	Adjusting the Number Format
	3.727e+000
	3.727
	3.73
	15 Displacement.
	Double-click the Displacement1 (-Res disp-) plot. Displacement numbers tend to be small, and in this chart they run between 0 and about 3 mm. They are in scientific notation but would be easier to read in a decimal format.
	Where to Find It
	16 Chart options.
	Right-click the Displacement1 (-Res disp-) plot and click Chart Options. Under Position/Format, select Number Format floating.
	The numbers appear as easier to read floating format numbers.
	Click .



	Solution
	1 Decrease the load to increase the FOS to a value greater than 1.
	2 Add cross bracing to the unbraced sections.
	17 Close the part.
	Click File, Close and click Save to save changes.
	Finishing the Bracing
	1 Open the part file.
	Click Open .
	From the Open window, browse to the Lesson 4 folder.
	Select TRUSS_4.sldprt, and click Open.
	This version is similar to the previous one with full cross bracing.
	2 Rerun.
	Open the existing study Study1 and rerun the analysis.
	Compare Stresses
	3 Factor of safety plot.
	Create a factor of safety plot and check the value of the FOS.
	4 Maximize the external load.
	Again, we will maximize the load for a factor of safety of 1.
	5.64 x 5.4N = ________ N
	Edit the Force-1 feature external load and set it 30.46 N.
	5 Rerun.
	Click Simulation, Run to rerun the analysis. The minimum FOS should again be close to 1.
	6 Displacement.
	Double-click the Displacement1 (-Res disp-) plot. Animate the plot.
	7 Close the part.
	Click File, Close and click Save to save changes.


	Top Beams
	1 Open the part file.
	Click Open .
	From the Open window, browse to the Lesson 4 folder.
	Select TRUSS_5.sldprt, and click Open.
	This version is similar to the previous one with three top braces added.
	2 Open existing study.
	Open the existing study Study 1.
	3 Analysis and edits.
	Run the analysis and create a FOS plot. The FOS falls above 1.
	To bring the FOS closer to 1, change the load to 37.95 and rerun.
	4 Displacement.
	Although the additional bracing did very little to change the maximum load, it reduces the maximum displacement.
	Right-click the displacement result and select Edit Definition. Set the Deformed Shape to True scale and click . Also right-click Chart Options and select Floating as the Number Format.


	Strength to Weight Ratio
	What does our Structure Weigh?
	Where to Find It
	5 Mass properties.
	Click Tools, Evaluate, Mass Properties to list the mass properties of the part. The key information is the line for Mass. This is the total weight of the structure in grams.
	Click Close.
	Note: Conversion of grams to newtons: 1 gram is about 0.01 newtons.

	Efficiency Comparison
	TRUSS_1
	20N
	4.566 g = ______N
	________
	TRUSS_2
	13.68N
	7.418 g =______N
	________
	TRUSS_3
	21.6N
	8.266 g =______N
	________
	TRUSS_4
	121.84N
	9.130 g =______N
	________
	TRUSS_5
	151.8N
	9.508 g =______N
	________
	6 Close the part.
	Click File, Close and click Save to save changes.


	More to Explore
	Axial Force
	Shear Force (directional)
	Moment (directional)
	Torque
	Reading the Plot
	Note: The axial forces in the vertical member nearest the external loads are very small because the braces absorb most of the load.
	Lesson 5: Using an Assembly

	Goals for This Lesson
	Testing an Assembly
	Testing using the Test Block
	1 Open the assembly file.
	Click Open . From the Open window, browse to the Bridge Design Project\Student\Lesson 5 folder. Select Test_Block_Assembly.sldasm, and click Open. The assembly includes a copy of the previous structure and a representation of a wood block.
	Where to Find It
	2 Move component.
	Select the Load_Plate_75 component and click Tools, Component, Move. In the dialog, click Collision Detection, All components, Stop at collision, Highlight faces and Sound. Select and drag the Load_Plate_75 through the structure. It should move smoot...
	3 Fit.
	The block fits through the structure. In fact, there is a larger clearance than is needed. To get the most efficient structure, we want to limit the width of the structure so that the block fits with a very small clearance.
	Click .



	Changing the Model
	4 Expand features.
	In the FeatureManager, double-click the Test_Block_Truss component and then the Roadway folder to expand them.
	Double-click the Sketch1 feature.
	5 Change dimension.
	Double-click the 75 dimension and change it to 60. Click Rebuild and . The structure part changes size.

	Collision Detection
	6 Move.
	Using the same Move procedure as before (step 2), try to move the block through the structure. It collides with the structure.
	7 Increase width.
	Using the same dimension change procedure as before (step 5), change the dimension to 74mm.
	8 Correct size.
	This size provides a small clearance and allows the block to slide through.
	9 Open the part.
	Right-click on the Test_Block_Truss in the FeatureManager and select Open Part . The structure part opens in its own window.
	Updating the Analysis
	10 Warnings and errors.
	Click Study 1. There are warning and error markers on several features.
	11 Joint group.
	Right-click the Joint Group and select Edit.
	Click Calculate and .
	12 Fixture.
	Right-click the fixture Immovable-1 and select Edit Definition. Check to see that the same four (green) joints are selected and click .
	13 Load.
	Right-click the external load Force-1 (:Per item: -37.95 N:) and select Edit Definition. Check to see that the four joints as shown are selected and click .
	14 Mesh and run.
	Right-click the Mesh feature and select Mesh and Run. The changes are insignificant. Click File, Close and save all changes.
	Lesson 6: Making Drawings of the Structure


	Goals of This Lesson
	Drawings
	Creating a Drawing and Views
	1 Open the part file Drawings.
	From the Open window, browse to the Bridge Design Project\Student\Lesson 6 folder.
	The part is a completed model of the structure.
	2 Open drawing file.
	This part has an associated drawing file. It has no drawing views or notes, but it contains many of the setting that we need. To open it, right-click in the graphics area, then click Open Drawing.
	3 Expand View Palette.
	Click on the View Palette to expand it. The view palette contains views of the current part. Click Refresh and clear Import Annotations. Drag and drop an *Isometric view from the View Palette to the drawing sheet.
	4 Drawing view properties.
	Select Shaded With Edges from Display Style. Click Use sheet scale.
	Click to complete the view.
	What is a Weldment Cut List Table?
	Where to Find It
	5 Weldment Cut List.
	Click Insert, Tables, Weldment Cut List and select the drawing view.
	Select the file Bridge_Weldments.sldwldtbt as the Table Template.
	The file is stored in the folder Bridge Design Project\Student\Lesson 6, the same folder as the part.
	Click and move the cursor onto the drawing.
	6 Place table.
	Move to the upper left corner of the drawing and click to place the table.
	7 Resize columns.
	Drag the column and row borders of the table to resize them. Each column and row border can be resized.


	Why are there two Items of the Same Length?
	Tip: In the building section the actual sizes of the individual beams will be listed.

	Balloons
	Where to Find It
	8 Balloons.
	Click Balloon. Click on the member and then click to place the text. Repeat the process to add some balloons.
	Click .
	Note: You can move balloons by dragging the text.
	9 Balloon quantities.
	The quantity of items in a balloon can be set. Click a balloon and click Quantity.
	Select a Placement and click .
	10 Close the drawing and part.
	Click File, Close and save all the files.
	Lesson 7: Reports and SOLIDWORKS eDrawings



	Goals of This Lesson
	Reports and SOLIDWORKS eDrawings
	1 Open the part file Reports&eDrawings.
	From the Open window, browse to the Bridge Design Project\Student\Lesson 7 folder.
	Open the part file Reports&eDrawings. Click Static 1 and run the analysis.

	Creating a Report
	Where to Find It
	2 Report.
	Click Simulation, Report.
	3 Dialog.
	Click Designer and Company. In Designer, add your initials. In Company, add the name of your school.
	4 Logo.
	Click Logo. Click the Browse button and select the file logo.bmp from the Lesson 7 folder.
	5 Description.
	Click Description and type This is the structural analysis of a balsa wood truss into the comments section and click Publish.

	Tip: The Report path can be set to receive the report and associated data.
	6 Report.
	The report, complete with data and images, appears in a new window as soon as it is generated. Close the window or print the report.
	Note: Do not close the part.



	SOLIDWORKS eDrawings for Sharing Information
	Advantages of eDrawings
	Viewing eDrawings
	Viewing eDrawing Animations


	Creating a SOLIDWORKS eDrawing
	7 Plot.
	Double-click the Displacement1 (-Res disp-) plot to activate it. This is the plot that will be saved into the eDrawing.
	8 Save.
	Click Simulation, Result Tools, Save As. Save the data using the eDrawings Files (*.analysis.eprt) file type. Click Save.
	The default name is of the form: part name-study name-results-plot type. In this case it is Reports&eDrawings-Static 1-Results-Displacement1.analysis.eprt
	It is stored in the same folder that was created by the report.
	9 Open the eDrawing.
	Double-click the eDrawings file in the folder. The eDrawings window appears.
	Note: If eDrawings has not been used before, it may ask permission to load.
	The eDrawings User Interface.
	10 Settings.
	Click the Studies tab , and the options Show Mesh ,
	Show Legend and Show Title .

	eDrawings Functions
	11 Move components.
	Click Zoom to Area and drag a window around the center section of the structure.

	Playing an eDrawings Animation
	12 Play the animation.
	Click Play . This starts a continuous forward play loop showing each view in sequence. The animation sequence is system controlled; you cannot set the sequence.
	13 Stop the animation.
	Click Stop to stop the animation.
	14 Reset the view.
	To return the animation to the start of the sequence, click Reset .

	Saving eDrawings
	Save the eDrawing
	15 Save the eDrawing.
	Click File, Save As. For Save as type: click eDrawing HTML Files (*.htm) to save the eDrawing as an HTML file. This file can be viewed in a web browser. Click Save.
	Save the file in the Reports&eDrawings-Static 1 folder.
	16 Close all files.


	More to Explore
	Lesson 8: Building and Testing the Structure
	Goals of This Lesson
	Building the Structure
	Cutting to Length
	1 Open and print Measuring Chart.PDF file.
	Browse to the Lesson 8 folder, open the Measuring Chart.PDF file and print it using the precautions stated in the PDF and in the note below.
	Note: Print this PDF using the Page Scaling: None option to get accurate values!
	2 Open and print Construction Guide.PDF file.
	Open the Construction Guide.PDF file and print it.
	3 Lower frame.
	Glue the end cross beams to the long beams. Do not glue the interior cross beams yet.
	4 Fill in beams.
	Fill in between the beams (cross hatched area) by cutting beams to fit and placing them in position. Glue all beams.
	5 Triple outer rails.
	Glue the long beams over the fill in beams as shown. Glue all beams.
	6 Side walls.
	Glue all beams.
	Tip: You might want to build a side and then cross brace it (step 7 on page 88) before starting on the opposite side.
	7 Cross bracing.
	The brace members must all be cut (45 degrees) to fit within the existing framing. Glue all beams.
	8 Top cross supports.
	Glue all beams.




	Testing the Structure
	Creating the Span
	Details
	Tip: Make sure that the tables or sawhorses are strong enough to be able to take the load without bending.



	Applying the Load
	Using Common Objects with Known Weights
	50
	50 X 0.0245 = 1.225
	1
	$0.50
	100
	___X 0.0245 = _____
	____
	____
	500
	___X 0.0245 = _____
	____
	____
	1000
	___X 0.0245 = _____
	____
	____
	5000
	___X 0.0245 = _____
	____
	____
	Holding the Load
	Lesson 9: Weldment Profiles and Structural Members


	Goals of This Lesson
	Creating Weldment Profiles and Structural Members
	What is a Weldment?
	What are Structural Members?
	What are Weldment Profiles?
	Existing Weldment Profiles
	rectangular tube
	angle iron
	square tube
	c channel
	s section
	pipe

	Warning for Paths
	Note: None of the existing weldment profiles resemble the cross-section of the balsa wood sticks or their much larger relation, 2x4 lumber. This means that a new weldment profile must be created.



	Creating a New Weldment Profile
	The Weldment Profile Folder
	1 Folder.
	Click Start, Computer and browse to the folder C:\Program Files\ SOLIDWORKS Corp\SOLIDWORKS\lang\english\weldment profiles\ansi inch.
	See Warning for Paths on page 95 for more information.
	2 New folder.
	Click New folder and rename the folder to lumber.

	Creating a New Part
	Where to Find It
	3 New part.
	Click New. Click Part and OK.

	Changing the Unit System
	4 Unit system.
	Select IPS (inch, pound, second) from the Unit System menu . This changes the units to inches.
	Note: The menu is located on the bottom of the screen to the right of the message Editing Part as shown.

	Creating a New Sketch
	Where to Find It
	5 New sketch.
	Click Front Plane and click Sketch .


	Sketching a Rectangle
	Where to Find It
	6 Rectangle.
	Click Center Rectangle and click on the origin. Next, move diagonally away from center and click a location similar to that shown. Click .
	Note: The actual size is not important now. It will be defined in the following steps.


	Dimensioning
	Where to Find It
	7 Vertical dimension.
	Click Smart Dimension and click the left vertical line as shown. Move to the left and click again to place the dimension. In the dialog that appears, type 1.5 to set the dimension value and click .

	Geometry Color
	8 Horizontal dimension.
	Click the upper horizontal line as shown. Move up and click again to place the dimension. In the dialog that appears, type 3.5 to set the dimension value and click .
	Note: The geometry is all black meaning that it is fully defined.
	9 Exit the sketch.
	Click Exit Sketch in the upper right corner of the screen.


	Saving the Sketch as a Library Feature
	Where to Find It
	10 Library feature.
	Click Sketch1 in FeatureManager design tree.
	Click File, Save As.
	Click Save as type: Lib Feat Part (*.sldlfp).
	Browse to the folder C:\Program Files\SOLIDWORKS Corp\SOLIDWORKS\ lang\english\weldment profiles\ansi inch\lumber.
	Note: The selection of the sketch first is critical.
	11 Name.
	Type the name 2 by 4 and click Save.
	Note: A warning might appear saying that you do not have permission to save in this location. If this occurs, save the file to another location and then manually move it to the lumber folder in the location above.




	Creating a Similar Weldment Profile
	12 Save as.
	Click Save As, name the new library feature 2 by 6 and click Save.
	Edit Sketch
	Where to Find It
	13 Edit sketch.
	Right-click the sketch Sketch1 and click Edit Sketch . Double-click the 3.5 dimension and change it to 5.5. Click .
	14 Exit the sketch.
	Click Exit Sketch in the upper right corner of the screen.
	15 Save and close.
	Click File, Close and click Save.

	Additional Information About Weldment Profiles

	Creating the Weldment Sketch
	16 Open the part M Roof Truss.
	Click Open .
	From the Open window, click the type: SOLIDWORKS Files (*.sldprt; *.sldasm; *.slddrw) and browse to the Bridge Design Project\Student\Lesson 9 folder.
	Select M Roof Truss.sldprt and click Open.
	Note: The units of this part are feet with the material set as Pine.
	17 Change to front view.
	Click View Orientation and click Front .
	18 Edit sketch.
	Edit the sketch Sketch1. For more information, see Edit Sketch on page 101.
	Sketching a Line
	Where to Find It
	19 Vertical line.
	Click Line . Click at the origin, move vertically and click again as shown.
	Note: The Vertical relation marker indicates that the line is exactly vertical.
	20 Angled line.
	21 Vertical brace.
	Create a line by clicking on the lower horizontal line and moving vertically upwards. Click again on the angled line to create a short, vertical line.
	22 Angled brace.
	Move back to the origin and click again to create an angled brace. Click .
	23 Vertical dimension.
	Click Smart Dimension , click the vertical line and add a dimension. Set the dimension value to 5 as shown.
	24 Dimension between lines.
	Click the short vertical line followed by the center vertical line. Click below the sketch and place the dimension. Set the dimension value to 6 and Click .


	Mirror Entities
	Where to Find It
	25 Entities to mirror.
	Click Mirror Entities and click the three lines shown below.
	26 Mirror about.
	Click in the Mirror about field and click the center vertical line as shown. Click .
	27 Exit the sketch.
	Click Exit Sketch in the upper right corner of the screen.
	28 Save.
	Click Save .
	29 Change to isometric view.
	Click View Orientation and click Isometric .




	Adding the Structural Members
	Structural Member
	Group
	CommandManager Tabs
	Where to Find It
	30 Structural member.
	Click Structural Member and click ansi inch, lumber and 2 by 4. Click the lower horizontal line as shown. Do not click ok yet.
	Note: The preview shows the orientation of the profile as it is applied to the line.
	31 New group.
	Click New Group and select both of the upper angled lines. Do not click ok yet.
	32 Next new group.
	Click New Group and select the center vertical line. Do not click ok yet.
	33 Next new group.
	Click New Group and select both of the outer vertical lines. Do not click ok yet.
	34 Final new group.
	Click New Group and select both of the outer angled lines.
	Click .
	35 Change to front view.
	Click View Orientation and click Front .
	36 Hide sketch.
	Right-click Sketch1 and click Hide .


	Multiple Bodies
	37 Edit feature.
	Right-click the Structural Member1 feature and click Edit Feature .
	38 Change size.
	Select the Size 2 by 6 and click .
	39 Close the part.
	Click File, Close and click Save to save changes.
	Glossary
	The process modeling the behavior of a structure to determine whether it can withstand the external loads it is designed to handle. Quantities such as displacements, stresses and factor of safety are calculated.
	View a model or eDrawing in a dynamic manner. Animation simulates motion or displays different views.
	An assembly is a document in which parts, features, and other assemblies (sub-assemblies) are mated together. The parts and sub-assemblies exist in documents separate from the assembly. The extension for a SolidWorks assembly file name is *.sldasm.
	A beam is a structural member with a constant cross-section. It is usually loaded so that it bends.
	What happens to a beam when it is loaded along its length. Also called flexure.
	A component is any part or sub-assembly within an assembly.
	The movement of a beam from its original position after a load is applied.
	A SolidWorks document is a file containing a part, assembly, or drawing.
	A drawing is a 2D representation of a 3D part or assembly. The extension for a SolidWorks drawing file name is *.slddrw.
	A drawing sheet is a page in a drawing document.
	Compact representation of a part, assembly, or drawing. eDrawings are compact enough to email and can be created for a number of CAD file types including SolidWorks and SolidWorks data.
	A simple shape used to represent a small piece of the the model. The sum of all the elements represents the entire model.
	The outside factors that affect the structure. They include external loads applied to it and places where it is restrained from movement.
	A force or pressure that is applied to a structure from the outside. For a truss, it might be the weight of a train.
	A face is a selectable area (planar or otherwise) of a model or surface with boundaries that help define the shape of the model or surface. For example, a rectangular solid has six faces.
	A value that is calculated in an analysis that determines whether a structure is strong enough to withstand the external loads applied to it.
	A feature is an individual shape that, combined with other features, makes up a part or assembly. Features are always listed in the FeatureManager design tree.
	The FeatureManager design tree on the left side of the SolidWorks window provides an outline view of the active part, assembly, or drawing.
	Fixtures are used to limit movement of points in the model. They are also called constraints or restraints.
	The graphics area is the area in the SolidWorks window where the part, assembly, or drawing appears.
	A line is a straight sketch entity with two endpoints. A line can be created by projecting an external entity such as an edge, plane, axis, or sketch curve into the sketch.
	What is used to create the beams in the structure. In a real structure, it would commonly be steel, but it can be wood or concrete. We are using wood.
	The process of dividing the model into small pieces called elements.
	A model is the 3D solid geometry in a part or assembly document. If a part or assembly document contains multiple configurations, each configuration is a separate model.
	A named view is a specific view of a part or assembly (isometric, top, and so on), or a user-defined name for a specific view. Named views from the view orientation list can be inserted into drawings.
	The SI (m-kg-s) unit of force. A force of one newton will accelerate a mass of one kilogram at the rate of one meter per second per second. In traditional English terms, one newton is about 0.225 pounds of force (lbf). The newton is named for Isaac N...
	A point used to connect and shape elements.
	A part is a single 3D object made up of features. A part can become a component in an assembly, and it can be represented in 2D in a drawing. Examples of parts are bolt, pin, plate, and so on. The extension for a SolidWorks part file name is .sldprt.
	The SI (m-kg-s) unit of pressure and stress. It is defined as one newton per square meter. In traditional English terms, one pascal is about 145.04×10-6 pounds per square inch (psi). Because it is a very small amount, the related units MPa (Megapasc...
	A combination of four lines forming a rectangular shape in a sketch.
	The restraint describes that part of the model that cannot move in the analysis.
	A 2D sketch is a collection of lines and other 2D objects on a plane or face that forms the basis for a feature such as a base or a boss. A 3D sketch is non-planar and can be used to guide a sweep or loft, for example.
	The software within SolidWorks that is used to perform a structural analysis.
	A folder used to store a complete analysis including: materials, fixtures, external loads and mesh.
	A tree structure, similar to the FeatureManager Design Tree, that contains the features that make up a simulation.
	The strength or stiffness of a beam includes both the cross section shape (area moment of inertia) and material.
	Stress is a quantity measured by force per unit area inside a structure that is caused by external loads applied outside of the structure. Common units are Pascals and pounds per square inch.
	A “map” of colors that displays the amount of stress anywhere on the part. Colors are used to represent stress value ranges.
	A collection of beams that are used to form a single part. In SolidWorks, this type of part is called a weldment; multiple pieces welded into one.
	The stages in a generic analysis including pre-processing (setup), analysis and post-processing (looking at the results). Specifically, we use SolidWorks Simulation.
	A single body in a weldment structure that represents a beam or length of lumber.
	Internal forces in a beam that are caused by bending.
	A simple bridge structure usually used by railroads.
	A combination of length, mass and time units usually described by the selections such as IPS or MMGS.
	A structure based on a 2D or 3D sketch, a profile and multiple bodies in a single part.
	A 2D sketch that represents the cross-section of a structural member.
	The limit of a beam’s strength based on the stresses in the beam.




